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COMING NEXT MONTH
TUX shows you how to set up and
use Guarddog to secure your Linux
desktop and continues its series on
how to get the most out of the
OpenOffice.org spreadsheet.



After a few false starts on this month’s column, 
I went to one of my regular Web sites,
http://www.tuxmagazine.com, and read some of 
the comments. What I read inspired this editorial.

I read a “friendly argument” about which is easi-
er, Microsoft Windows or Linux. That is, easier to
install, easier to use, easier to administer or easier on
your sense of well being—all of these things. Is there
consensus? On the Web site, no, but for me, yes.
Each system is easier, in various ways, for each user.

This got me thinking about whether I do things
the hard way around here. That is, there are Linux
systems here. Would my life be easier if I had one or
more non-Linux systems in my life? Let me think out
loud a bit. You can listen in.

First, “around here” means a combination
house/office in Nicaragua. I have an office upstairs with
the desktop system I am writing on and what could
best be called a test system. There is also a laptop in
my life (there used to be two, but one recently died)
and another system downstairs in the living room.

The living room system is mostly there to keep
family members and neighbors away from my office
systems and, well, my office. Regular users on that
system include an adult non-geek and two teenage
girls. Occasional users include many other people.

Although a failure in that system doesn’t put me

off-line, having something reliable there means that 
I don’t have to stop working (because I have my 
own system up here) or share my other systems. The
“public” system has proved to be totally reliable in spite
of kids pushing the off button when they shouldn’t,
power failures and the general lack of computer
knowledge of the people who use that system.

The first plus I have with Linux on that system is
that I have multiple logins. The guest account is set
up in Spanish because most people here are native
Spanish speakers. I do have, however, another login
in English for out-of-town guests. The most difficult
transition between languages is for an English
speaker to find the right menu choice to end the
current session and get a new login prompt, because
the menu is in Spanish.

Let’s talk a little more about these users. One has
some limited experience with a Windows-based sys-
tem. The other two regular users have never used
Windows. That means they are learning from noth-
ing. Are they having any troubles? No. They send
and receive e-mail, play some games and, for the
most part, just do things on the Web using the
Konqueror browser.

In the last year, I have had to fix a problem on
that system only once. They were trying to play
some music on CD. Things looked okay, but there
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was no sound. It turns out that someone
(we suspect a little brother) had managed
to load the audio mixer panel and set the
CD volume to 0. That’s it.

Moving up to my office you will find
about 1,500 songs from CDs on the test
system. I loaded the CDs and ripped them
into Ogg Vorbis format because it is very
compact. As it is a test system, I put them
on a removable hard disk just in case I
want to do some serious playing. But, as
it is, any of the computers can access that
music. That’s a lot easier than trying to
find where the Workingman’s Dead CD
seems to have run off to.

I loaded Ubuntu Linux on my test 
system before writing the Ubuntu Linux
review for the TUX Web site. I am com-
pletely happy with it and will continue to
run it there.

I also have loaded Ubuntu on the lap-
top. Although it’s not perfect (it will not
hibernate with the Wi-Fi card plugged in),
it isn’t imperfect enough for me to want
to load something else or actually fix that
particular problem. That is the only prob-
lem I have experienced.

Now that all the non-important stuff is
out of the way, let me talk about what I
do on this desktop. Maybe we can figure
out why Linux isn’t the best choice.

Let me divide my computer use into
work and play. Now, for me play is not
like most people. I actually write pro-
grams as my fun activities on computers.

This will be a strange concept to most
TUX readers as well as most of the world.
So, let’s just ignore that part and get on
to how I use Linux-based computers to
get my work done.

The first thing you need to know is
what my job is. Even people who work for
me have asked what a publisher does.
Sometimes, I ask myself that same ques-
tion. The best answer is that he does all the
leftovers in producing magazines. I do all
the undefined, strange stuff that you don’t
see in each issue but has to get done.

That work includes a lot of communi-
cations with the rest of the staff, writing,
setting schedules and priorities and keep-
ing track of a lot of general concerns. I
generally describe my job as a high-end
clerk, but others point out that a lot of
background is needed in order to make
decisions. While part of this job is not
having typical days, let’s look at what
could be considered a representative day.
I’ll pick yesterday.

First on the list was to go through a
lot of e-mail that I had received since the
previous evening. I use mutt as an e-mail
client. It is not pretty at all, but it works
well for me because I have used it for
years and use it a lot. I don’t need fancy
stuff requiring mouse clicks to get in 
my way—I need efficiency. mutt offers
this efficiency.

I also need to be able to handle encrypt-
ed e-mail easily. This capability is integrated

into mutt, so all is well for me. If, however,
I wanted to use a graphical e-mail reader,
there are a lot of included choices. One,
Kmail, is very easy to use, offers features to
work with virtually every type of mail
account and handles encryption.

I also access one mail account using a
Web browser. This is fairly low volume,
but it is important to have that account
in case I am away from a system that I
have control over. I can read it with any
Web browser anywhere in the world. I
use Firefox as the browser for this
account on Linux, but there is nothing
special about using Firefox as opposed
to another browser.

Moving along in my day I need to
“chat” with one of the people I am work-
ing with. He is up early by my standards
because he is in Australia. Although there
are many chat protocols, we use Jabber.
One of the reasons we chose Jabber is
because we can create our own secure
Jabber server. We don’t have to take the
risks associated with using other chat pro-
tocols that use commercial servers.

I use Gaim for my Jabber client. Again,
there are lots of choices, but it has a look
and feel that appeals to me and it works
well. In addition, it supports other proto-
cols including AIM, ICQ and Yahoo IM. I
seldom use the other protocols, but hav-
ing them available means that if there is a
problem with our secure Jabber server, I
have another way to talk to people.
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In my conversation this morning, I was
sent a URL of a Web page I needed to
open up. Gaim highlighted it. I clicked on
it, and it opened a browser, which dis-
played the page for that URL.

In the morning e-mail, I received a PDF
document I needed to read and another
created in Microsoft Office. No problem;
my e-mail client opened up Adobe’s
Acroread for the PDF and OpenOffice.org
for the Word document. Possibly better
than no problem, if either mail had con-
tained a virus, it is unlikely it would attack
my Linux system and, beyond that, because
of the design of Linux, a successful virus in
e-mail still could do little damage.

Time to take a look at our TUX Web
site. Nothing magic here, but I tend to
use Firefox for this, and Konqueror for
other things. I keep Konqueror up on one
desktop and Firefox on another so it is
just a mouse click to get there. The multi-
ple desktops also make it easy for me to
have a lot of stuff waiting on my some-
times-slow Internet connection.

One new comment pointed to a possi-
ble bug with the magazine delivery sys-
tem. I reported this using DCL, a project-
tracking and reporting system. It has a
Web interface, so I had only to switch to
a different tab in the Web browser.

Phone call. I use Skype most of the
time. It runs on your computer and offers
voice-over-IP service. It runs on Linux as
well as other platforms.

Now, what’s for lunch? I guess you
can’t do everything with Linux. Well,
some people can—they might have a
microwave running embedded Linux to
heat up those leftovers, but I don’t.

Moving further into the day, Nick had
asked me to write an editorial. Well, here I
am. The file I am writing is just text, and I
am using vi, my favorite text editor. But, for
word processing, I have my choice of
OpenOffice.org, Kword and AbiWord. It’s
all here—I simply pick the tool that appeals.

Next, I get a request that doesn’t have
to do with work. Can you put the photos
from the party (last night) on the Web?
Okay. I use digiKam to grab the photos
from the camera and then Konqueror to
create a Web page with the photos.

During the day, I also made some
changes in my Palm Pilot PDA and some
changes in JPilot, the PIM application I run
on my desktop. I synchronized the Pilot
with the program JPilot with Bluetooth.

As the day goes on, I do more e-mail,
go to more Web sites, chat using Jabber
more and edit more text files. I wrote a
little six-line program in Ruby to get the
answer to a question I was asked. And, I
downloaded and watched a movie
(QuickTime format) about setting up
some software.

That’s my user side of using Linux. I
can’t think of anything here that could be
easier—no matter what system I am
using. It all just works. But, what about

administration?
Other than performing occasional

backups (I tend to archive to CDs using
K3b to write them and do disaster back-
ups to magnetic tape using tar), I haven’t
done any administration—in ages.
Checking, I see the computer has been
up only 15 days since the last reboot.
Why? Because the power was off for a
few hours 15 days ago.

One other administrative function I
perform is on-line software updates.
Although this could be completely auto-
matic, I picked the “do it when I tell you”
option. So, that means bringing up the
update program occasionally and then
agreeing with its choices.

I could talk about how easy (or hard)
the system was to install, but it was done
long enough ago that I really just remem-
ber putting in the DVD and answering the
expected kind of questions (time zone, IP
address, hostname and so forth). Next
time I upgrade this system, I will see if
Nick wants me to tell you how difficult it
was. Of course, you will have to invent
your own comparison as I have installed
Linux only in recent history.

Guess that’s about it. I just need to run
the spell-checker on this file and e-mail it
to Nick. Then I will do some after-work
shopping, looking for that Linux-based
microwave oven.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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Here’s how to make Linux a better desktop operating system
for all users. Complain. I’ll explain in a moment.

Linux is already perfect for many desktop users. Almost
every distribution includes every possible application a normal
user could want or need. It runs flawlessly. For this particular
user, the chosen Linux distribution supports all the peripher-
als. Everything works, including the scanner, the wireless or
LAN network adapter, the printer, the funky keyboard with all
those special keys, the latest mouse, the DVD-RW drive and
even the Wacom drawing tablet. Normal programs never
crash. Programs that are still under development may crash,
but Linux is so robust that the crash doesn’t affect anything
else running on the system. You simply need to restart the
unstable program. The Linux desktop is almost impervious to
viruses and trojans, and few, if any, exist (known malicious
software is usually targeted at server software, and even
those programs rarely do any damage). What could be more
perfect than that?

But Linux is not perfect for all desktop users. Last year, I
bought a Samsung Laser printer because it is dirt cheap and
offers high-quality printing. It also has a “toner-saver” mode
for those times when you don’t need a professional-looking
printout. There was no “in-the-box” support for it with any
version of Linux I tried. I had to download drivers from the
Samsung Web site. The installer for the drivers didn’t work on
my machine. I hacked my way into getting the printer to
work. Fortunately, I was a programmer in a former life, so I’m

rarely intimidated by obstacles like these. But no normal user
could or should have to guess how to solve a driver problem
like this one.

Most of the current Linux distributions include support for
this laser printer now. The lesson here is that, in many cases, if
you wait long enough, Linux will support the product you
bought. This is unacceptable, of course, if you want the prod-
uct NOW. But it is currently how things work.

The down side is that there’s also no telling how long
you’ll have to wait. For example, the only Linux distribution
I know of that supports my Linksys WUSB11 version 2.6
USB wireless network adapter is Linspire, and this adapter
has been around so long it is practically obsolete. It is a
nightmare to get the adapter configured properly on any
other distribution, because it doesn’t compile with the 
latest kernels, and there are no clear instructions on how 
to configure this adapter for permanent use.

At least geeks like myself can get that adapter running. 
No Linux distribution currently has a chance to support the
Visioneer OneTouch 9320 scanner I bought a few weeks ago.
Why? In part because it’s fairly new, and nobody in the Open
Source community has reverse-engineered a working driver
for it yet. There’s no telling how long it will be before I can
use this scanner with Linux, if ever, but I can take the CD out
of the scanner box and install the driver for Windows without
any problems.

Moral: for anyone who wants to use the OneTouch

How to Make Linux Perfect for the Desktop
How you can help to make Linux a better desktop operating system.

NICHOLAS PETRELEY

FROM THE EDITOR IN CHIEF
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9320, Linux is not the perfect desktop.
For anyone who wants anything new
that is unsupported, Linux is not the
perfect desktop.

In fact, the most common complaint
about Linux is lack of driver support for
the most recently released products. One
of the most frequently asked questions we
see on Linux Web sites and forums every-
where goes like this: “How do I get my
[this model of printer, camera, whatever]

working?” Sometimes there are solutions.
Sometimes there are not. When the solu-
tions exist, they often involve operations
that no average user would or should
ever have to perform.

THE ANSWER
There are two solutions to this problem,
and I strongly suggest you use both:

1. If you are about to buy any new
device, find out which brands and
models are supported in Linux, and
choose from among those models.

2. This is far more important. If there

was a brand and model you would
have preferred to buy, complain.
Loudly, and repeatedly. Call and
write Visioneer, Hewlett-Packard,
Canon, Samsung or whomever, and
complain that you can’t use their
product with Linux.

Call and write the manufacturer of the
product you really wanted. Tell them that
you didn’t buy it because it doesn’t work

with Linux. More important, tell them
which product you bought instead,
because it did work with Linux. If you
already bought something that doesn’t
work with Linux, call and write the manu-
facture and tell them that you’re return-
ing their product and exchanging it for a
competitor’s product that DOES work
with Linux.

The complaint approach will work only
if everyone takes my advice. One call
from a disgruntled would-be customer
means nothing to a company. So they lost
one customer. So what? On the other
hand, thousands of calls get results.
That’s called demand. When there is a

enough of a demand for Linux support, a
company will supply it.

I can’t repeat or emphasize this part
of the advice enough. If you have even
the slightest preference for any product
that doesn’t work with Linux, don’t be
content to buy an alternative that Linux
supports. Complain to the manufacturer
of the product you really wanted, and
rub it in their faces that you will have to
buy a competitor’s product because the

competitor’s product works with Linux.
Wait a week. Call again and tell them
that you still really want to buy their
product—ask them if it is has Linux sup-
port yet. Do that again and again, week
after week. If enough people follow this
advice, and enough people are vigilant
about doing it repeatedly, I guarantee
you will start to see Linux support for
almost every product on the shelves of
Best Buy, Circuit City or anywhere else
you shop.�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and Linux analyst for Evans Data Corp.
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Thanks for Writing
Thank you for all your letters. We at TUX wish
we could print them all, but space requirements
prohibit this. We also wish we could help you
solve some of the problems you may be having,
especially those who have problems with the
TUX PDF file (such as the person who said KDE’s
window manager crashes when escaping out of
full-screen mode). Unfortunately, many of these
problems are unique to a particular installation
or configuration and would require gobs of addi-
tional information (and time) to find your partic-
ular problems, so there isn’t much we can do on
an individual basis. As for the more general
issues with publishing TUX as a PDF file, rest
assured we are working hard to make TUX as
easy to use and easy to read for as many people
as possible. So keep sending us your suggestions
and complaints. They may not make it to print,
but we are paying attention.—Ed.

Making XMMS Big
I read the response to Valerie Higgins’ letter
“Reading the Small Print” [TUX, June 2005, page
6]. Her letter dealt with the XMMS small print, or
rather the small size. I carefully re-read the editor’s
response to her.

Needless to say, the red flags went up like crazy—
this ain’t right. I have XMMS up and running as I
write on MEPIS Linux 3.3 on a 17" monitor at
1280x1024.

However, there are some letters that run down
the left side of XMMS next to the digital
timer/equalizer bars. They go like this:

O
A
I
D
V or U

I guess you could say very few people ask “why?”
I did, and from the very first clicked all of them to
see what they did. It just so happens that clicking
the D doubles the size of the skin to a much more
readable size.

I hope this helps. Of course, I am taking for
granted that XMMS has the same basic black
skin with blue and white lettering for other 
distro’s besides MEPIS.
--
Dennis

Well, dang if you ain’t right. This is by far the
cracker-jack solution to the itsy-bitsy size of
XMMS. If we old folks had eyesight like you
young whippersnappers, we might have found
those letters and played with them enough to find
out what D does. Unfortunately for some of us,
like this old flatulence here, we picked a skin that
just has dots or other bumps instead of letters. I
guess we’s magically supposed to know these

dots ain’t there fer just decoration. But to all you
other old folks at home, press the dot next to the
bottom, or the letter that’d look like D if you got
out yer magnifying glass to look at it. Bingo.
XMMS is big. It ain’t so pretty without anti-aliased
fonts, but at least we old folks can see it. Thanks,
Dennis for your observation!—ye olde Ed.

Go Mango
I just read the letter entitled “Disturbed by Mango”
in issue 3’s letters and think your response was
excellent and appropriate. Coming from an Irish
background, I feel that if I can enjoy a good Irish
joke, then others should not get wound up by other
light-hearted ethnic puns. Learn how to laugh it off
is my suggestion to those folks. If something is
clearly not intended to offend or denigrate, then
why get upset? Well, I think some people aren’t
happy unless they ARE upset.

I also like Mango’s light-hearted approach. Just
because TUX is a technical mag doesn’t mean it
has to be all earnest overtures and business-world
tone. I get enough of that in the plethora of
unnecessary meetings I have to attend each week,
so people can put on their best suits and play
Captain Corporate. As far as I’m concerned, if
Mango teaches me stuff in her column, I’m really
not too concerned as to how she goes about it.
So more power to her!
--
Dave Rogers
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Pun, Anyone?
Hear, hear! I commend you on your decision to
tell a PC pundit to take a hike. It is truly sad that
that some people cannot accept a simple pun
anymore.

As for the pundit: take your politically correct
rhetoric somewhere else. I’ll bet most readers are
here to support their favorite OS and maybe have
a laugh in the process.
--
Jon

Stand Up for Mango
I was reading Mr Phelps letter, “Disturbed by
Mango” [*sigh*] and was hoping that in your
response you wouldn’t cow-tow to that sort of
thinking. I was glad to see you stand up for
Mango...too often businesses take the easy way
out and, rather than risk offending someone, sim-
ply apologize for no good reason. I guess it’s true
that no matter what happens someone will find a
way to take it too seriously. Please keep up the
great work, and tell Mango to keep her articles
interesting to read!
--
Dana McNeil

Bad Mango
Friends: I’d like to echo the responses written by
Scott Phelps and Brian Sexton, as published in the
third issue. As an absolute newbie to Linux, I’m look-
ing forward to the helpfulness of the publication, 
but I, too, decry the tone of the Parfait column. 
You responded to Mr Phelps “There is no possible

way to twist....” I beg to differ strongly; there are
hundreds of ways to twist such material, and the
taunters and bullies of the world are experts at
doing so. Although I don’t enjoy the “froth” of
Parfait, I’ll look past it to find the pearls of wisdom.
It’s okay to have fun with your publication, but fun
at someone else’s expense is unacceptable. In the
examples already noted by Mr Phelps, hundreds 
and perhaps thousands of “someone elses” were
targets; that this was unwitting is no excuse. Please
consider discarding such references and practices in
the future and thus raise the level of communication
to a higher standard.

There are plenty of worthy directions in which to
expend your collective efforts in bringing out a
useful publication. For example, in the article
about installing MEPIS 3.3, author Roy Brander
wrote “It’s not stupid to want exact instructions
the first time you tackle something!” But I found
that the steps included in the article for obtaining
and using Smart Boot Manager didn’t work; I had
to insert a step at which I transferred the down-
loaded file to a floppy diskette first, before typing
the smbimst command (if that’s what it indeed
is....I’m too new to know even that for sure). And
I also found that all of the info links on the SBM
Web page that was given in the article were bro-
ken. I had to use Google to search for SBM at a
different site in order to get access to such useful
things as documentation. Lack of attention to that
sort of detail points to the need for more editorial
effort aimed at the utility of the publication.
--
Robert Gates, (no known relation to you-know-who)

Opinions
“...a passionately strong supporter of
Israel.....Mango insists she is entitled to her opin-
ions...” OF COURSE SHE IS, especially in a society
where one could get away with multiple rapes (and
murders) but not a tiny unintentional hint that
might somehow be misinterpreted as being slightly
touching any criticism of the weak, fragile (Mosad-
lacking), heartbreaking, poor, underfunded, never-
involved-in-any-kind-of-espionage-especially-against-
allies, deprived of any kind of international support,
honestly peace-seeking, unaffiliated with the notori-
ous Sabra and Shatilla or Der Yasin massacres,
oppressed, surrounded by monstrous superpower
(and very very STRONG and capable) enemies,
underarmed, famine struck, never-harmed-a-fly and
the absolutely-unsupported-by-a-lobby-stronger-
than-the-president-of-the-united-states-himself
heart-breaking STATE OF ISRAEL. POOR MANGO,
she’s just using constitutional rights to show 
passionate support [in a technical computer 
magazine!!!!!!!] of a leviathanic political force that
can efficiently crush any opponent....How brave of
her, how courageous, how honest and right-
eous....Good work Mango, you skillfully kept your
job and the approval of the surrounding “society”
but (and now it’s my turn to say my Opinion) on the
way, I think you either lost your common sense or
your dignity.
--
Bashar

Both you and Mango have a right to your 
opinions. She gave hers in a few words. We
just published yours in its entirety.—Ed.
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Autopackage
The article by John Knight in the third issue was
great. I too had run across Autopackage and felt
it was about time for this in Linux. Being a devel-
oper, I’ve felt there are way too many choices
when it comes to trying to distribute my software.
When I suggested in the past that there should be
a package like this, it was promptly put down as a
bad and easy way to have bad programs install in
Linux. My response is that I could get a bad pro-
gram distributed to me in an RPM or DEB format,
but I was told that that just wouldn’t happen. It
seems as if the need for security was greater than
the need for simplicity. Then it came to my atten-
tion that an open-source package, NSIS
(http://nsis.sourceforge.net), a scripting language
to create easy-to-install software on Windows,
had similar issues with bad software. People need
to know that virii, trojans and spyware will be part
of our everyday computer life, just like we have
bugs that invade our homes. Just because we
want to keep things difficult will not stop these
intruders. We need a single method to distribute
software to Linux systems. It does need to be sim-
ple for users, but it needs to handle the complexi-
ties of making sure that all libraries and other
needed software is installed on the system where
it is to be used as well. Hopefully, Autopackage
will become widely used, then we can have a tool
like NSIS for Linux to make building installation
packages easier also.
--
Jim Ward

Easy Installs Needed
John Knight’s article on Autopackage is right on
the money [June 2005]! Unless Linux adopts an
easy-to-use, one-click software configuration, all is
lost and new users will quickly abandon this OS
for Mac and Windows.

For instance, in the same issue, Quasar
Accounting was reviewed. The reviewer stated
that installation was easy. Simply download the
client, server and icu packages and install. Hello!!!
How the heck do I do that?

Luckily, there’s a single Windows .exe file avail-
able for download. I’m switching over to my
Windows partition to single click on this and
try out Quasar Accounting. Right now, I can’t
do this in Mandrake without jumping through
a whole buncha hoops (I’m an Average Joe
Linux User).

If Autopackage were available with Quasar
Accounting (and other software titles), I’d have
no need to reboot into Windows. Linux needs
to make software installation a no-brainer. Can
anyone please tell me how to upgrade from
Mozilla 1.6 to 1.7 in Mandrake? In Windows, I
just download an .exe and install. Bingo!
Mozilla is upgraded. Having the same easy
approach in Linux will keep me, others and new
users in the OS.
--
Mark Szorady

GRAMPS
This is in regards to Herb Taylor’s letter in the 
3rd issue. Mr Taylor asks about a good genealogy
program for Linux. I would like to point him 
to GRAMPS (http://gramps.sourceforge.net). 
It runs great on Red Hat/Fedora and SUSE 
(SUSE 9.3 is my distro of choice) and has a lot 
of nice features.
--
Kevin W. Peters

Editorial Calendar
From the back page of your first issue, I was look-
ing forward to your May edition as the “Home
Entertainment” special. I was disappointed to find
no mention of the topics you had advertised.
What happened? And, are these topics scheduled
for a later issue?
--
David Jenn

The editorial calendar is designed primarily for
advertisers who may want to match ads for
their products to the issue topics. We have
been straying from it for various reasons. For
example, sometimes the articles we assign to
address a topic are not up to snuff, so we print
better articles in their place, even if they are
off-topic. But the main reason we stray from
the editorial calendar is the catch-22 of adver-
tising. TUX is on the bleeding edge. Although
we are certain that Linux is growing on the
desktop in a big way, many advertisers are not
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yet convinced. It takes cold hard cash to fund
the people-power necessary to produce a mag-
azine that can always be on-topic, every month.
As TUX gathers more and more advertisers,
we will have the funds necessary to get on
schedule and stay there. So keep your eye on
the calendar. At some point, we will be able to
follow it more closely and, eventually, follow it
with gusto.—Ed.

Font Size?
Your response to Valerie Higgins letter was the
most condescending and arrogant reply I have
ever seen in a magazine. I might be willing to
lug the +31" monitor onto the plane so I could
read your nasty responses on my laptop, but
I’m afraid I might have some difficulty plugging
it in to a power source. But the issue is really
whether you want people to be able to read
your publication on or not. You use an insanely
small font and then blame the viewer for hav-
ing such poor eyesight and recommend that
your customer jump through a hoop and wear
reading glasses over their regular glasses to be
able to read your wonderfully exciting rag.

Better idea. The thing is electronic anyway.
INCREASE THE SIZE OF YOUR D___ FONT! 
You could do this quite easily. So do it.
--
L. D. Matteson

Advice
Hi, My name is Jason Holland and I am a recover-
ing Windows user. I have been Windows-free for
six months and nine days now. I would like to
thank the staff of TUX magazine for being a
wonderful sponsor.

I want to thank the Editor for supporting Mango’s
freedom of speech, and “strongly” mentioning
that people are far too sensitive. I am a firm
believer in laughter as a preventative medicine,
and many times it relieves a lot of stress, if only
for a moment.

In regards to your article in the June 2005 issue on
Quasar Accounting, which was wonderful, I will
quote the first paragraph: “One of the biggest-
claimed obstacles slowing the adoption of Linux on
the desktop of small and medium enterprises (SMEs)
is the lack of certain types of software....”

I would like to point out a few business applica-
tions that I feel are missing:

� A program for flow-charting at the same level
of capability as Visio.

� A program for project management, feature-
rich and competing with Microsoft Project.

� Several browser plugins like Shockwave Flash.
And no I don’t mean Flash; I mean Shockwave

Flash. It is entirely different. Many of the busi-
ness applications today are moving to Web-
based technology (such as training applica-
tions), and they require Shockwave and other
technologies that currently are not supported
on Linux, like Windows Media Player 9.

I am aware of a lot of applications that are similar, 
like Kivio, Dia, Planner and the like. However, not all
of these applications are available by default in each
distribution. In addition, many companies are devel-
oping applications that “require” Windows Media
Player, Internet Explorer and other items that are spe-
cific to Microsoft and cannot be installed on Linux. A
perfect example would be Windows Media Player 9. 
I have tried many times to install and configure it on
Linux to no avail—even with CrossOver Office.

To sum it up, here is an idea I have had that 
has been brewing since issue 1. Have a monthly 
article that covers a single common office 
function/application, what’s available, and how 
to install/use the most common or best of the
products available on the market. These are a few
article titles that may give you a better under-
standing of what I mean: “Productivity Corner”,
“Open Source - Office Applications”, “SOMO
(Small Office Medium Office) Application
Solutions”, “It’s not just for Microsoft anymore...”
and “COST (Complete Office Solutions Technicals)”.
--
Jason Holland
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Endless Chains of Links?
I like TUX magazine, and playing with Linux has
become my newest hobby.

PLEASE make good on your promise regarding
help concerning hardware configuration. Step-by-
step instructions regarding software installation
also would be helpful.

Unfortunately, I am perceiving Linux as the “Tower
of Babel” of OSes. Many, many distros and on-line
help links linking to other on-line links, etc, etc. Few,
if any, sources of organized, concise information.

Thirty years of technical background, three weeks’
effort, and I STILL can’t get a silly Wi-Fi card
configured. If I were doing this for a living, my
boss would be FURIOUS with me!

Yes, I know there are many worthwhile applica-
tions for Linux. But touting them is not going to
improve the overall state of the art, or adoption
rate, of this intriguing OS.
--
Bob Grzesik

One of the missions of TUX is to provide a compre-
hensive alternative to “solve the problem by following
endless chains of links” syndrome. Send an e-mail to
mango@tuxmagazine.com about your Wi-Fi card
problem. If there is a way to get it to work, she
should be able to get you on track without sending
you on any wild-goose chases.—Ed.

More Macs and Linux
A friend of mine got me interested in Linux,
and I have been playing around with the
Xandros distribution on an old PC I had laying
around. Mainly, however, I am a Mac user. I
have several Macs at home running OS X, and I
must say I’ve been pleased with how easy my
Mac family members connected to their new
Linux sister. I’ve noticed a lot of articles in TUX
about Windows and Linux connectivity. How
about some articles on Macs and Linux living
together? Remember, we Mac users already
hate Windows.
--
ldond

GRUB
I have been really enjoying the first three issues
of TUX—great articles, pleasing format. Roy
Brander’s “How to Install Mepis 3.3 Simply”
was invaluable in helping me decide which
Linux version to try. It did leave me with a 
question, however. I intend to install Mepis 
on the second drive (hdb) of a system that is
running Win98 on the first drive (hda). When
configuring GRUB, do I install it on hda or hdb?
Also, since I’m a little nervous about messing
up the Win 98 Boot sector, is there a way to
install GRUB on a bootable floppy or CD?
Thanks for a great magazine.
--
Bob Stewart

In most cases it is safe to install GRUB over the
master boot record on your first drive even if
you have Windows installed. The trick is 
configuring GRUB to boot Windows after that.
But it is pretty easy to install GRUB on a floppy.
First, make sure you have edited menu.lst
(which is just a link to grub.conf) to include
boot instructions for both Windows and Linux.
Follow these commands:

mke2fs /dev/fd0

mkdir /floppy

mount /dev/fd0 /floppy

cd /floppy

mkdir -p boot/grub

cd /boot/grub

cp stage1 stage2 menu.lst grub.conf device.map

/floppy/boot/grub

cp /boot/message /floppy/boot

Start GRUB with the command grub, then issue
these commands:

device (fd0) /dev/fd0

root (fd0)

setup (fd0)

quit

If memory serves, that should do the trick for
you. If we missed anything or it doesn’t work
for you for any reason, send an e-mail to
mango@tuxmagazine.com, and she should be
able to fill in any blanks and additions.—Ed.
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Accessing Windows Shares
First of all, great magazine!! There are a lot of
us Windows users out here that are new Linux
users that really need some help and the mag
is there for us.

There is an article in the June 2005 issue with
the title “Linux does Windows” where the
author says that you can access Windows
shares through Konqueror with a few clicks of
the mouse. I beg to differ. Unless there is some
sort of explanation as to how you can do this in
some obscure manual out in cyberspace, he is
fairly far off-base. The article did not mention
how you could accomplish this task. As far as I
can tell, it takes a lot of command-line file edit-
ing to get this to work. It would be helpful if
authors that make claims like this would actual-
ly explain how they did something and not just
say that it is so. I have been going around and
around in forums about this same subject. I
have yet to see the simple solution.
--
Drew

There are simple solutions. For example, KDE
Konqueror (especially the latest version, 3.4.x)
makes it very easy to access Windows shares
with a few mouse clicks, as long as you have
the right supporting software installed. We
have an article in the works describing how to
do this. It was originally scheduled for the same

issue as the article you read, but for various
reasons, it has been delayed to appear in a
future issue, hopefully next month.—Ed.

Read This Book
I am a new user to Linux. [...] I have found the
following on-line and PDF book invaluable:
Introduction to Linux, A hands-on Guide by
Machtelt Garrels (http://www.tldp.org/LDP/
intro-linux/intro-linux.pdf). It is updated now
and again and explains the fundamentals of
Linux in a concise and understandable manner.
Again I have no connection other than as a
contented reader.
--
Iain Mckeand

Digital Audio Workstation
Hey guys, the magazine rocks! I’m a linux noob
about to install kubuntu on my laptop. I want to
make it into a Digital Audio Workstation. Any sug-
gestions on software to use? If it helps, I make
electronic/industrial pattern-based music, using
midi and samples. 1,000 Thanx.
--
the hematurge

It would take a book to describe how to turn
Linux into a full-blown digital audio and video
workstation. We will address these topics a piece
at a time, though.—Ed.

Scribus
I was highly impressed by the landscape layout
of TUX, issue 1 and its general concept. I was
pleased to read in the June 2005 issue you are
aiming to use Scribus from issue 4 onward.

I have been using Scribus for quite some time
now, out of interest for DTP in general as well as
producing my motorcycle club magazine, and
because professional packages are simply too
expensive for me. After receiving your first issue,
I tried to create a magazine of my own along the
same principles using Scribus, although of course
I am not a DTP pro in any way.

It was fun to do and I learned more about DTP
too. I will be looking forward to your next issue
and wish you all the best in your efforts produc-
ing that with Scribus. It will be interesting for me
as a mere amateur to see what a professional
will accomplish!
--
Just Vecht

Gadget Question
I read with great interest the Gadget Guy’s (Sean
Carruthers) review of Gigabyte USB Flash drives in
the March 2005 issue. However, being a newbie to
Linux, I’m a bit perplexed at how one actually goes
about using these things without opening a shell
and issuing a bunch of jibberish. Has the issue of
desktop mounting when inserting the key been
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solved or is there a way script the mount proce-
dure and maybe assign it to a keystroke shortcut? I
apologize for the apparent lunacy of this question
(at least from the locals I ask), but you state in
your publication that it’s for new users.

I read the first and second issues cover to cover
without putting either down, so it’s going to
be difficult to wait until the July issue arrives
for a possible answer. Hopefully someone will
send me a tutorial or point me to a source. I’ve
been searching but have not found the usable
solution yet. That’s the disadvantage of using a
GUI where everything is done for you.

Thanks for a GREAT publication. I hope you have
a long and prosperous run.
--
Bill O’Brien

Sean’s reply: I’m still a relative Linux newbie
myself—it’s a good way for me to make sure
that these gadgets are going to be relatively safe
for Linux newbies too. During my testing, I was
running SUSE version 9.1, and when I plugged
the Flash drives in, detection was automatic and
the drives immediately appeared as a removable
drive, right next to the CD drives. I didn’t have to
do any scripting or reconfiguration in order to
use them. I’ve since moved to version 9.3, and
there’s been no change.

It’s my understanding that most recent versions
of Linux should treat removable drives this way—
the editors can provide a reality check here if this
isn’t the case, though—and it only makes sense.
As Linux evolves into an operating system that’s
more and more friendly for newbies, stuff like
this has to become automatic, or it’s a failure for
all concerned.

PCLOS
I’ve come across a distro called PCLOS and
think it is properly suited for your target audi-
ence. I’d like to see a good review on it. The
only complaint that I have is that the man
pages aren’t included, and I’d like to see if that
is a valid concern or not. I’d like to know
whether your reviewers think that this OS is as
sweet as I do, and based on that, whether man
is even needed anymore.
--
Nino

We are looking forward to printing a review of
pclinuxos soon after the next version is released.
This isn’t the only distribution without man
pages, and you raise a good question as to
whether or not they are needed. Personally, I
want them. But if a distribution is meant to be
point-and-click, it’s possible they aren’t neces-
sary. Each to his own.—Ed.

Linux to the Rescue
Six months ago, a spyware invasion crippled my
computer. I knew a good friend who had used
Linux for years, so he recommended that I
install Fedora Core 3 and offered his help to
get me up and running. Needless to say, I was
overwhelmed at the amount of software avail-
able. How can one person ever learn to use it
all? I have tinkered, played, learned much
myself, posted help requests on various sites
and made many mistakes. I was so glad to
come across a link to your magazine. First, the
magazine format is beautiful in Adobe 7.0 on
my 17" monitor. I can sit back, relax, and read
the screen just like a magazine! Additionally, it
is simple, clear and perfect for someone like
myself who is new to Linux. After reading your
first two issues, I now can effectively use KGet,
amaroK, digiKam and aKregator. Wow, I am
organized and I called a friend this morning to
wish her a happy birthday after my Kalarm
went off! I look forward to a complete and
lengthy article detailing some of the uses of
the various office suites available
(OpenOffice.org, Koffice). What a fantastic
service you are doing for the new Linux user.
Your publication should be a default on the
desktop of every new Linux installation!
--
Mark�
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Hello to everyone again! Thank you for
all your questions. There are so many
questions in my inbox it is very hard to
choose which to answer. TUX is for
desktop Linux users, so I will try to stay
with questions about the Linux desktop
and desktop programs. Again, I regret
to remind you that I do not have time
to answer e-mail directly. Please do not
be insulted if you ask for a personal
reply and do not get one. I also regret
that this month I am very cranky and
maybe some of my answers are cranky
too. I try to work things out with my 
ex-boyfriend Otaku, but he complains
that I watch too much Azumanga
Daioh and I am becoming like Chiyo-san,
a ten-year-old who makes older girls
mad because she is smarter than they
are. It is my favorite show. So if
Otaku doesn’t like it, I don’t care. 
He can watch his favorite shows, 
and so can I. Okay. Now that I am
done complaining, we can get on
with the questions.

Q Hi, I would like to know if I can
install Linux on a secondary hard

drive and keep Windows on the first drive
for a dual boot?—Michael

A Every decent distribution of Linux
lets you do this. Each distribution

may walk you through the installation
for this in different ways, but they
almost always give you the option to
install Linux on the second, third or any
other drive.

If your Linux distribution does not give
you that option, you may need to install
it in expert mode. Many distributions
designed to make installation as easy as
possible will assume you want to wipe
out your first hard drive and put Linux on
it. Read the installation screens carefully.
If one says it is going to wipe out your
first drive, do not continue installing
Linux. These distributions often let you
pick an expert mode somewhere during
installation. This lets you tell the installer
to put Linux on a different hard drive.

Here is the hard part. The expert
mode and even some default installers
make you partition the hard drive. 
This just means you are going to 
split up pieces of the hard drive for 
different purposes.

Here is how to make your life easy.
Create only two partitions. One will be a
swap partition. Don’t worry about what
this is, you just need it. Before you make
any partitions, decide how big your swap
partition will be. Linux geeks argue about
the best size for a swap partition all the
time. I make my swap partition twice the
size of my installed memory. If you have
512 megabytes of RAM, make your swap
partition 1 gigabyte. If you don’t have a
big disk, you probably can find a spam e-
mail that will tell you how you can buy
some goofy product that will make your
disk bigger. No, I get that wrong. I mean
if your second drive doesn’t have a lot of
gigabytes, then make the swap partition
the same size as your RAM.

When you get to the part of your

Q&A with Mango Parfait
Cranky Mango solves a common GNOME problem and talks about partitions and files.
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installation where you have to partition
your hard drive, choose the second drive
(usually /dev/hdb or /dev/sdb) and create
only two partitions. Make the first parti-
tion the root partition. Some distributions
do not call it the root partition. They call
it the / partition—same thing, different
words. Define the size of your root parti-
tion by subtracting the swap size from
the size of the whole disk. If you have an
80 gigabyte disk, and you want a 1 giga-
byte swap partition, define the root parti-
tion to be 79 gigabytes. You probably will
have to tell the installer what kind of
filesystem you want to use. If you are a
beginner, use the filesystem called ext3. If
you are not a beginner, you don’t need
me telling you any of this.

After you create the root partition, cre-
ate the swap partition and tell it to use
the rest of the space on your drive. You
may have to tell your installer that this
partition is the swap partition. It probably
won’t figure that out by itself.

When the installer asks you where to
put the boot manager (it probably will be
called grub or lilo), tell it to install the
boot manager on the master boot record
of the first drive (usually /dev/hda or
/dev/sda). Most of the best distributions
have installers that will see that you have
Windows installed. They will create an
entry in your boot manager automatically

that lets you boot Windows instead of
Linux. If you are not using one of these
distributions, you may have to tell the
installer to add Windows as a boot
option. I cannot help you here, because
different Linux installers handle this in dif-
ferent ways. The easiest way to make
sure you don’t mess up is to pick a popu-
lar Linux distribution with a good reputa-
tion. It probably will take care of the
Windows boot option for you.

Q Your oblique references to “If you
knew Suse” (sic) are those of the

generation that preceded mine. I believe
your nom de plume and assumed identity
is that of somebody considerably older.
—Fred Kasner

A Oh, stuff your conspiracy theories in
your zoot suit! I used to be a wait-

ress at an Asian buffet. If I had one penny
for every time I heard the joke “If you
knew sushi like I know sushi”, I would be
so rich I would not have to write this col-
umn. I never heard the song you say in
your letter is by Eddie Cantor (I never
heard of Eddie Cantor), but I hear this
corny joke all the time. It would be easy
for me to think of the same joke using
SUSE, but this time blame my editor, who
changes and adds too many things to my
writing. I tell him not to add corny jokes

because mine are much more clever. I am
very Americanized and I speak fluent
English, but he still changes my words
and adds to them. I would like to say that
if he lived close enough I would turn him
into a GIMP. I would like to say that. But
a reader already complained that using
the word GIMP is insensitive to handi-
capped people, so I will not say that. By
the way, anybody who watches reruns of
Daffy Duck or Popeye cartoons knows
what a zoot suit is, so don’t get any more
conspiracy ideas.

[Mango, you are lucky that I do not
offend easily, and even luckier that the
publisher, not I, hired you. I tried to leave
more of your text alone this time. But if
you come here with any ideas about get-
ting tough, I will sic my attack parrot on
you, and I don’t mean (sic).—Ed.]

Q How do I set the numlock key to be
on by default in GNOME?—John Q.

Public (many readers asked this same
question)

A The important word is default. Here
is what I want you to do. I want

you to follow my instructions on how to
make numlock come on by default in
GNOME and count every keystroke and
mouse click it takes to finish. If you have
a Linux distribution that makes it hard to
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find the program you need, you will
make many more keystrokes and mouse
clicks than maybe a Debian user. Count
them anyway.

Here are the instructions for the easi-
est way I know to turn on numlock auto-
matically in GNOME. Install a package
that is called numlock or numlockx. Some
Linux distributions call the package num-
lock. Some distributions call the package
numlockx. It is the same program. The
program turns on the numlock key when
you run a graphical desktop like GNOME.

You can use this program with any
graphical desktop, but you do not need it
for KDE. KDE already has a configuration
option for setting the numlock key, which
is reason number 1,739 for why you
should use KDE and not GNOME.

Another reason to use KDE and not
GNOME is that some people say the num-
lock key makes GNOME go crazy. Maybe
that is why KDE makes it easy to make
numlock turn on by default and GNOME
does not. GNOME does not go crazy for
me with the numlock key on so I do not
give it a reason number. But if it goes
crazy for you, I told you to use KDE and
you should have listened.

It could take pages and pages to
explain how to find this package for every
distribution. So here are only some com-
mon examples. The rest of you are on
your own to look for the package.

If you are running Debian or one of
the many Debian-based distributions
(Knoppix, Mepis and so on), start up your
package manager. Most Debian and

Debian-clone users seem to like the pack-
age manager called Synaptic. Find
Synaptic on your desktop menu and start
it. When you start Synaptic, you should
get a pop-up window asking for the root
password. Type the root password and
press Enter. Then press the Search button
and type the word “numlock” and press
Enter. See Figure 1 for what Synaptic
should look like now.

Click on the numlockx package listed
on the right that you found. Click the
Apply button. You should see what you
see in Figure 2.

Click the Apply button in this window.
Synaptic will install the numlockx package.

If you have KDE on your system, you
can use Kpackage to install numlockx.
Find Kpackage on your desktop menu
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Figure 1. Search found numlockx in Synaptic. Figure 2. Synaptic about to install numlockx.
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and start it. Click on the New tab. Enter
“numlockx” in the search field. Highlight
(click on) the numlockx package and click
the Install button on the lower right. See
Figure 3 to see what this looks like.

If you are using Fedora Core 3, 
use your browser to go to this URL:
http://mpeters.us/yum/fedora/3/i386/
RPMS.yjl/numlock-0.1-0.0.yjl.1.i386.rpm.

If you do not find this file, maybe the
version changed. If that happens, use the
browser to go to the URL http://mpeters.us/
yum/fedora/3/i386/RPMS.yjl, look for the
numlock package in the list and click on
that package to download it.

The browser should ask you where to

save the RPM file for the num-
lock package. Save the file to
your desktop. Look for the icon
for this package on your desk-
top when you are finished
downloading. Right-click on the
icon and choose Open with
Install Packages from the pop-up
menu. It will ask you for the
root password. Type in the root
password, and follow the
prompts to install this package.

Now you need to configure
GNOME to start the numlock or
numlockx program every time you
start GNOME. This example uses

numlock as the program, but if your
package is called numlockx, you need to
change your typing to numlockx.

Look for the item Sessions in your
GNOME menu. You probably will find it in
the Preferences submenu, or even the
More Preferences sub-submenu. Click on
the Sessions menu choice. You will see a
window like the one in Figure 4.

Click on the Startup Programs tab. See
Figure 5 to see what you should see.

Click the + Add button. You will see a
pop-up dialog like the one in Figure 6.
Type “numlock” if the package you
installed was called numlock. Type
“numlockx” if the package you installed
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Figure 4. The Sessions Dialog
Figure 3. Installing numlockx with Kpackage.

Figure 5. Startup Programs
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was numlockx. Then click OK.
If you do everything right, you should

see something like you see in Figure 7.
Click the Close button and you are

done. When you start GNOME again,
numlock will be on.

Now here is an easier way that I know
of to turn on numlock in GNOME. Start
GNOME. If your keyboard has a numlock
key, press the numlock key. You do not like
this, perhaps, because it is not automatic.
Did you count how many keystrokes and
mouse clicks you made to install the pack-
age and make it run automatically in
GNOME? 25? 50? 100? Maybe more for
people who need to search for a package
that works for them. That is how many
times you need to start GNOME to make it
worth the effort to make numlock come
on without pressing the numlock key. If
that is okay with you, what can I say?
Zoot-suit yourself.

Q Dear Mango, I have been through
hell trying to find a basic CD set

that explains Linux for the beginner. [I
want] just the simple nuts and bolts and
explanations of naming conventions (if
there are any); how you recognize an exe
file from another type of file and installing
using the terminal (I don’t know how many
times I have tried to do the ./configure
and config and make and makefile from
the terminal and not understood a word in
the README files that makes any sense
and then have the file extract in some far-
off directory I cannot trace and then try to
get a link to the desktop).—Alec Jones

A If you are not a Linux geek, why
are you compiling your own pro-

grams? If you insist on doing this, my
first recommendation for you is to seek
professional help. I mean the kind
where they give you mood-altering pills.
My next advice is to stop making pro-
grams yourself and download a pack-
age that has the program precompiled
and tested with your distribution of
Linux. If you cannot find a precompiled
version of any program that you want
to install easily on your distribution of
Linux, either you are not looking hard
enough, or you are using the wrong
distribution of Linux.

Okay, now that I have given you a
proper whipping, I will answer your
question anyway. If you really insist on
making programs yourself and learning
about the Linux filesystem, here is what
I have to say. If you truly want to know
the rules for the Linux filesystem, I
would point you to the Web page for
the Filesystem Hierarchy Standard
(http://www.pathname.com/fhs). Most
Linux distributions use this standard,
more or less, and most Linux distribu-
tions break the standard too. So do not
bother trying to decipher it. I can save
you time.

Here are the basics. The /sbin directory
is for necessary system programs to boot
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Figure 6. Adding numlock to startup programs.

Figure 7. The program numlock is added to
the startup programs.

http://www.pathname.com/fhs
http://www.tuxmagazine.com


Linux and to use if you are the root
administrator. Don’t put anything in /sbin.
Let your distribution do that when you
install packages. The /bin directory is filled
with necessary programs any normal user
can run. All the commands in /bin are
commands Linux command-line users run
every day, so they are given names that
do not provide any clue about what the
commands do—like cat, awk and grep.
Do not put any programs in here either. If
you disobey me and put something here,
make sure you give the program a name
nobody can understand.

The /etc directory is mostly for config-
uration files and startup files. The
/usr/share directory also has configuration
files, but it is used mainly for non-pro-
gram files that have to be shared by every
user on the system. Every program that a
normal desktop user runs should be in
the directory /usr/bin. Many distributions
put important programs in other directo-
ries, so do not count on your distribution
using this rule all the time. Most shared
libraries go in /usr/lib.

Those are the basics. But if you 
are trying something as geeky as
./configure, make and make install,
then here is a thumb rule. If you make
a program with only those commands,
it is most likely going to install every-

thing in /usr/local by default. The 
programs will go in /usr/local/bin, the
configuration files will probably go 
in /usr/local/etc, shared libraries will
probably go in /usr/local/lib, shared 
files will probably go in /usr/local/share,
etc., etc., etc. You can tell the 
./configure command to put all the
files somewhere else, but that can get
you into trouble if you do not know
what you are doing. So, just let the
make install put everything in
/usr/local, and look in /usr/local/bin if
you want to find the program you need
when you create an icon to start it on
the desktop.

One more thing. Your Linux distribu-
tion must already have certain paths
set so that it will look into places 
like /usr/local/bin and /usr/local/lib
automatically. If not, you probably
won’t be able to run the programs in
/usr/local/bin. Most Linux distributions
set these paths for you. If your Linux
distribution didn’t do that, the people
who made your distribution were not
very considerate. Uninstall it and try
another distribution.

But my last word is to stop using
./configure and find packages that are
already compiled and use them instead.

You also ask in another part of your

letter how Linux knows when a file is a
movie, an OpenOffice.org document or
something else. Linux uses many different
ways to do this, and it should know a 
lot about the kinds of files you have
already. If you use KDE or GNOME, you
can “teach” these desktops to use any
program you want to open files.

Because you are brave and use the
command line, here is a way to find
out what a file is. Type the command
file <filename>. It will tell you what
type of file this is. Linux does not
always care about file extensions. 
Try this to see. Find a graphics file 
like picture.jpg. Copy it or rename it to
picture. Be more daring. Rename the
file to picture.gif and try to fool Linux
into thinking this is a GIF file and not 
a JPEG file. Now use the command
file picture.gif. You see? Linux still
knows this is a JPEG file. The wrong
extension will trick some desktops, but
not the file command.�

I am a sweet, humble, delicate and very cute
genius who is at your service to answer your
Linux questions. Send your questions to
mango@tuxmagazine.com. I am deeply sorry that
I do not have time to respond to anyone directly
by e-mail, but I will select as many questions as I
can and answer them here.
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What do you do with all those little snippets of
information that everyone seems to be responsible
for remembering? Do they end up on those little
yellow notepads? You know the ones I mean, the
ones with the adhesive strip along the back. The
ones that end up stuck on the frame around the
monitor screen, making it look like some sort of
mutant daisy. I bet one or more of them is a list of
login IDs and passwords too. I will hold most of
my comments on that topic for another article
except for one, little, shame on you.

So, what is it about those little notes that
make them so ubiquitous?

After years of exhaustive research and analysis
conducted at great expense, I believe I have uncov-
ered the secret, and I am ready to share it now
with my fellow readers of TUX. The secret is sim-
plicity. Simplicity makes them not only easy to use,
but it also means that they easily are used for
whatever you want to use them for, whether that
be for keeping track of passwords (shame again),
recipes, phone numbers, lists or any other small bits
of information you want or need to keep track of.

I always have found it odd that people, myself
included, who are sitting at a computer would
need to reach for a little yellow pad of paper to
keep track of information. After all, isn’t that
what computers are designed to help us with?

A lot of people, and even big software develop-
ers, have tried to develop electronic versions of these

LLeett  aa  TToommbbooyy  MMaannaaggee  YYoouurr  NNootteess
Tomboy is a notepad tool that goes way beyond what you can do with post-it notes.

SHANNON BAKER
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little pads of paper. KDE has a notepad that looks
like those 3M post-it notes. Microsoft even added its
version of these things in Outlook. Most of these
have focused on duplicating the look and feel of
post-it notes rather than paying attention to the pos-
sible features a computer could add to the basic
functions of post-it notes. For example, you can’t do
spell-checking on a paper note. But, computers are
adept at tasks like search and spell-checking. I tried
many of these programs, but still the paper petals
around my monitor have remained.

Then, I began to explore the world of open-
source software. I have found that not only the
direct replacements for software such as Windows
and Office were just as good, if not better, but I also
have found really innovative tools and solutions
without any equivalent. One of the tools I found is a
software package called Tomboy from Beatnik
Software (http://www.beatniksoftware.com), which
as far as I am concerned, is an almost perfect
replacement for those little yellow pads.

Tomboy (Figure 1) is a simple note-taking appli-
cation that captures not only the simplicity and
ease of use of the little yellow paper notepads but
combines it with really useful features you will
never find in ordinary paper—features such as
rich-text formatting, the ability to link key words,
spell-check and a search feature. Not only that,
but like Firefox, it is designed to be extended easily
through the use of plugins.

Tomboy runs as a panel object on the GNOME
desktop. Once you add it to your panel, it always
runs in the GNOME toolbar.

Here’s what you do. Install the Tomboy pack-
age, and then right-click anywhere on the
GNOME panel, and click the option that reads
Add to Panel. You will see a list of applets that
can be added to the panel; simply scroll down

until you see the entry
for Tomboy and select
it. Once this is complet-
ed, Tomboy is ready for
you whenever you log
in. When you click
Tomboy (Figure 2), the
icon opens a menu that
allows you to create a
new note, access a
recently created note or
search through all your
notes. This easy access
is one of the best fea-
tures of Tomboy. It is
easy to access any fea-
ture, since it is never
more than a couple of
clicks away. It is just as
easy to create a new
note in Tomboy as is it
is to reach for that pad
of paper.

Once you open a
note, simply start typing. Don’t worry too much
about spelling because spell-check automatically
highlights misspelled words with a red squiggly
underline, exactly like in your favorite word
processor. Also like a word processor, you can for-
mat the text. You can bold, highlight, strikeout
and italicize text. You also can change the font
size from small to huge; simply select the word or
words you want to change, and then click the text
button on the menu and you are good to go
(Figure 3). It is all rather intuitive and most likely
takes longer to explain than it does to learn on
your own.

The linking feature is probably the most com-

plicated feature. Select any word or phrase in your
note and click on the Link button. Then, you can
create a new note with the selected word or
phrase as the title. Now, the word or phrase you
chose, and every other occurrence of the link
word or phrase, in every note, automatically
becomes a link to the new note. This is a power-
ful feature. If you create a task list, for example,
you can link each task to a detailed description on
a separate note. It is only a click away. It is as sim-
ple to organize thoughts and ideas as typing a
name and then pressing the Link button. The links
between your ideas won’t break. If you rename 
a link, it does not break the existing links. As a
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Figure 2. The Tomboy Menu
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matter of fact, it changes the text in each of your notes to reflect
the changes you made in the original.

Have you ever written that key phone number or address on a
sticky note and not been able to find it later? That won’t happen
with Tomboy. Click the Search Notes option, and Tomboy opens a
window (Figure 4) where you can search through every note on
your computer. Do you need to find that certain note? It is a quick
search away. Tomboy also helps keep you from losing any infor-
mation by automatically saving each note as you type it.

Tomboy is a GNOME application. Although I am sure some
longtime Linux users out there could make it work with KDE, I
have not been successful.

Another piece of software called Mono also is required for
Tomboy to install and run successfully. Mono is an open-source
implementation of .NET, sponsored by Novell. This is a dependency

and must be installed prior to installing Tomboy. Many package
managers such as Synaptic will identify and take care of these
dependencies for you.

So, what can you use Tomboy for? Whatever you want. Just
like those little notepads, the uses are limited only by your imagi-
nation. You could use it to keep track of personal information,
such as contacts or to-do lists. My wife uses it to capture random
thoughts and ideas. As an aspiring author, I use it to keep track of
the various story elements such as locations, characters, events
and time lines. It is so easy to use, I am sure you will find uses I
have never even thought of.

There is still a pad of yellow sticky notes next to my computer,
but I almost never touch them. It is just as convenient to use
Tomboy. And, now my monitor does not look like a mutant daisy
or sunflower any more!�
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Many office environments make extensive use of spreadsheets. The reasons
why are no mystery, as spreadsheets allow you to collect large amounts of
data and, more important, allow you to try out a series of hypothetical
situations to see their impact in your specific situation.

If you’ve been a computer user for some time, it is likely that you have
used at least one type of spreadsheet application or another. For those of
you that have used other spreadsheet applications in the past and simply
want to become acquainted with OpenOffice.org’s Calc application, you’ll
probably want to skip to section two, or if you’re more adventurous, simply
open up OpenOffice.org and start doing what you need to do.

OpenOffice.org Calc is quite similar to many of the major office spread-
sheet applications. Feel free to scan the article to figure out what you need
to know if you get stuck, but in my experience, the best way to learn if you
are switching to OpenOffice.org Calc from another office suite spreadsheet 
is simply to start playing. For everyone else, I’m going to explain the general
elements of a spreadsheet so that we can all start with some common
ground. In my next article, we’ll get into more depth on how to use
OpenOffice.org Calc.

WHAT IS A SPREADSHEET ANYWAY?
A spreadsheet is nothing more than a table. We call single spaces used to
store information cells. Rows and columns of these cells make up a spread-
sheet. Take a look at Figure 1.

I’m just going to say this now. There are lots and lots of buttons. Don’t let
this overwhelm you. These are largely there to save you time, and they will in
the long run. Using a spreadsheet application is extremely easy. I’m going to
explain more than enough to get you started, and once you’re comfortable
with that, you’ll be able to forge your own path, or read the next article and
go from there.

As you can see in Figure 1, the rows are labeled with numbers, and the

columns are labeled with letters. So, to reference a single cell, you’d give its
coordinates by which column it resides in, and then which row. That means that
the top-left cell would be called cell A1. A cell three columns to the right and
four rows down would be called cell C4. I know this seems strange and useless
at this point, but don’t worry. It’s important to be able to refer to cells with a
coordinate system for formulas, which will be covered in the next article. Also, I
refer to cells by their coordinates because it’s much less confusing than trying to
explain, “The cell four up from where you entered the last data.”

GGeettttiinngg  SSttaarrtteedd  wwiitthh  OOppeennOOffffiiccee..oorrgg  CCaallcc
Never used a spreadsheet before? Here’s how to get started by using OpenOffice.org Calc.

KEVIN BRANDES
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In its simplest form, a spreadsheet can keep track of your data. The tabu-
lar format allows for keeping track of financial, scientific and many other
forms of numerical data. We create one of these spreadsheets in this article.
Later, when you actually start utilizing the power of spreadsheets, the sheet
can perform many complex calculations, and it either will take care of the
calculations for you or allow you to perform complex hypothetical calcula-
tions, simply by entering a new number where the real value used to be. So,
let’s get started.

GETTING STARTED WITH OPENOFFICE.ORG’S CALC APPLICATION
The first thing to do, in any case, is to open the application. On KDE, this is
usually located under a heading called Office in the K menu. This is where it’s
located on my SUSE Linux 9.2 system. You may have to browse your own
menu to find the
selection to start
OpenOffice.org Calc if
you are using another
Linux distribution or if
you are using another
desktop, such as
GNOME.

You also could navi-
gate to Office Suite
directly under Office.
The Office Suite icon
allows you to access all
the parts of
OpenOffice.org and
start with a specific lay-
out and kind of docu-
ment. We simply want
to start with a blank
spreadsheet in this
case, so go ahead and
click on OpenOffice.org
Calc instead of the
Office Suite icon if it
exists on your system.

You’ll be greeted with an empty spreadsheet that looks like Figure 1.
The first step we take is to begin entering data. To navigate to a cell, you

can use the mouse to click on the desired cell, or if your hands are off the
mouse and you need to move around, it’s faster to use the arrow keys on
the keyboard. Let’s go ahead and create a table of data so you can get some
practice entering information. Feel free to start your own spreadsheet and
follow along.

We’re going to create a quarterly earnings table like the one shown 
in Figure 3.

Of course, the data isn’t the most accurate in the world, but it’ll get you
used to entering data and formatting the cells to make the data look nice
and easier to read.

Start with a blank spreadsheet. The first thing that we’re going to do is
create headings (labels) to keep the data organized. Start with the title. Click
the cell D1 or use the keyboard to navigate to cell D1, type the title
“Quarterly Earnings (2005)” and press Enter. Use your mouse or the arrow
keys to navigate to the other cells until your spreadsheet looks like Figure 4.

If you put some information in the wrong place, or simply decide to move it,
you can move it around by selecting (clicking on, or using the arrow keys to
move the cursor to) the cell, and then selecting Edit→Cut, selecting the destina-
tion cell and then selecting Edit→Paste, like in many other office applications.

SUITED UP
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Figure 2. Starting OpenOffice.org

Figure 3. The Finished Product
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Now we’re going to insert the numbers. Feel free to choose your own
data, or use the numbers you see in Figure 5. You can type a number and
then press Enter to move down to the next cell in a column. This makes data
entry go more quickly. Try to avoid using the mouse. You can improve your
overall speed by using the arrow keys instead, at least once you become
comfortable with the application. Your spreadsheet should now look some-
thing like Figure 5.

At this point, you’ve put a fair amount of work into your spreadsheet.
You wouldn’t want to lose that work under any circumstances. This would
be a great time to save. Click on the disk icon in the toolbar, and you’ll see a
window that allows you to choose a filename and location for your file. In
Linux, spaces and most symbols are perfectly acceptable in a filename. Give
your spreadsheet a meaningful name. I chose Quarterly Earnings (2005) as 
is shown in Figure 6. The default extension of an OpenOffice.org Calc
spreadsheet at the time of this writing is *.sxc. An extension is simply the
last portion of a filename that is one way your computer can figure out how
to handle the file. This extension will be changing in OpenOffice.org 2.0, but

don’t worry, the old format still will be supported in newer versions. Select
Ok, and your work is saved to disk.

We need to add a little bit of formatting to make the sheet easier on the
eyes. First, we should make the heading larger. I’d like to point out some-
thing here. The text in cell D1 is too large to fit in that cell, so it’s overflow-
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Figure 5. Starting to Look Presentable

Figure 6. Save your work often!

Figure 4. The First Steps
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ing into cell E1. Select cell D1. If you look at the text entry bar among the
toolbars, you’ll notice that when you have cell D1 selected, you’ll see all of
the text, and in cell E1, you’ll see nothing. This means that all of the text is
actually in cell D1, and OpenOffice.org Calc decided it would be better to
show the text on the next cell, rather than have it end at the cell border. This
may seem confusing at first, but it really does make more sense once you’ve
gotten used to things.

Now we need to touch up the title. You should have already selected cell
D1. Now drop down the font size menu by clicking on the arrow where the
number appears (the font size selector should be to the right of the font
name selector). Select something larger. I chose size 16.

Now we need to align the data labels. Select the rectangular region of cells
starting with cell C3 and extend the selection to cell G4. You can do this with
the mouse, but it is probably easier to do it with the keyboard. Select cell C3,
and then hold down the Shift key while using the arrow keys to move to cell G4.
Once you have that range of cells selected, you can change the alignment
(among other things). Change the alignment to center the numbers by clicking
the center button in the toolbar. The center tool button is the one where you see
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Figure 7. Choosing Font Size

Figure 8. Centering the Data Labels

Figure 9. It’s coming together!
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different lengths of hori-
zontal lines, all centered
in the button.

Now you should
right-align the contents
of cell A7. Select cell
A7, and click the right-
align button (it is imme-
diately to the right of
the center-align button).
Your sheet should now
look like Figure 9.

The final touch for
this spreadsheet is to
add some lines on the
table so that the data
stands out and the val-
ues are easy to find.
Select cells B4 to G4
(select the cell B4, hold
down the Shift key and then use the arrow keys
to navigate to G4). Next, select Format from the
main menu, and then select Cells from that menu,
as shown in Figure 10.

This shows a new window with many options.
Click on the Borders tab at the top of the win-
dow, and your screen will match Figure 11.

In the section toward the left labeled User
Defined, you can add your own borders however
you like to the cells of the sheet. In our case, we
want a single horizontal line at the bottom of the
cells we’ve selected, so we click on the white area
toward the bottom of the User Defined area. This
makes a line appear where you’ve clicked. If the
line doesn’t match Figure 12, simply click again in
the same place to make the line go away. Once
you have a single horizontal line at the bottom of
the User Defined area, click Ok.

Once the dialog disappears, you’ll need 
to select a different cell to see the results of
your handiwork.

Now, we just need to add the vertical line.
Select cells B4 to B8 using your mouse or the key-
board technique we described in previous opera-
tions (click on the first cell, hold down the Shift key
and navigate to the last cell). Select Format→Cells
from the main menu again. This time, the Borders
tab already should be highlighted. Click on the
right side of the User Defined area, and then click
Ok. Once you select another cell on the sheet, you
should see the finished product. Save your finished
work, and you’ve created a simple spreadsheet.

At this point, you really haven’t even begun to see
the power of what you can do with spreadsheets. In
the next issue of TUX, I’ll cover some of the more
powerful functions of OpenOffice.org Calc.�
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Figure 10. Adding Our Horizontal Line

Figure 11. The Borders Dialog

Figure 12. Adding Our Line
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This is a good-news article. The good news is
that security in Linux is great and can be made
even better by doing a little work and following
a few simple rules. We need to be clear that no
computer system is ever totally secure. Before we
go into the rules or some of the easy things you
can do to make Linux even more secure, let’s go
over some of the things that make Linux as good
as it is today.

In the grand scheme of computer operating
systems, Linux is an old-timer. Linux security roots
are in UNIX, which has been running computer
systems for more than 30 years. One of the basic
design rules of UNIX was to write small utilities
and modules that did only one thing and did that
thing very, very well—so well that nobody would
ever be tempted to reintroduce that functionality.
What this has led to is an excellent set of tools
that have been refined over a decade. This leads
to operating system maturity and gives all of us
the benefit of years of troubleshooting and bug
fixing of the tools that we use every day. Most of
these low-level tools are hidden from you by your
desktop manager, but they form the foundation
of your distribution. Interestingly enough, these
tools were added to the Linux kernel several years
after each of them existed independently. They
are known as the GNU utilities. The GNU-Linux
marriage has been past the honeymoon for 

nearly a decade now, so we can count on these
tools to do exactly what they were designed for
and nothing more or less. The GNU toolset is a
huge security feature of Linux distributions and an
unsung hero of the capabilities we enjoy today.

Another advantage of Linux is that it was
designed from the beginning to separate users
from the ability to damage the operating system.
When you are using a Linux operating system as a
regular user, the designers have given you a lot of
power and ability to perform tasks, but they have
not given you the ability to damage the basic
operating system installation. In general, in Linux,
when you are logged in and operating as a regu-
lar user, you cannot harm the basic installation.

BEST PRACTICES
This leads us to the first rule of running a secure
Linux installation. Never run as the root user. Yes,
you will need root access to perform occasional
chores, and some Linux distributions make this
easier than others. Some distributions simply pop-
up a dialog window when you attempt to make a
change to your system that requires root privileges.
You type in the root password, and that takes you
to an easy-to-use configuration program for your
network card or anything else that is system-relat-
ed. When you exit this utility, you leave behind
your root privileges and continue using the system

with the more limited user privileges.
Regardless, you must get into the habit of log-

ging in as a regular user, and never logging in as
root. This practice protects you not only from
yourself, but from other malicious parasites who
seem to exist these days to cause other people
pain. As long as you are logged in as a regular
user, it is nearly impossible for a worm, virus, tro-
jan, hijacker, cracker or any malicious piece of
software to damage your operating system.

Didn’t I tell you it was good news? So, let me
repeat that. Run as root only for administration
duties. As soon as you are done with your
administration duties, get back into regular user
mode. If you follow this rule religiously, you will
never regret it.

The second practice that will give you a more
secure Linux experience is to keep your distribution
up to date. This means that you should regularly
apply patches that update the software that you
have installed on your computer. For most major
distributions of Linux, the basic update mechanism
is very easy to use. In many cases, it will tell you
when you need to run it. I happen to like Fedora
Core as my desktop distribution of choice, and I
prefer the KDE desktop. If you are running this
combination yourself, you will notice a circle over
in the lower right of your taskbar that is either a
green check mark or red X. If it is green, your

IInnttrroodduuccttiioonn  ttoo  LLiinnuuxx  SSeeccuurriittyy,,  PPaarrtt  II
Phil Barnett explains why security is important and gives some tips as a prelude
to next month’s how-to guide for the popular firewall program Guarddog.

PHIL BARNETT
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patches are up to date. If it is red, you need to
patch up your operating system. If it is red, simply
click on it. It will ask for the root password and will
prompt you through the update process. I like to
do this weekly or whenever I have heard that a
major vulnerability has been patched.

The third practice that will help your Linux
installation be more secure is to run the firewall
that is included in all modern Linux distributions.
A firewall is a defense mechanism built in to Linux
that keeps uninvited Internet or network traffic
from getting inside.

Why does this matter you ask? I mean, it’s
merely a home computer. Who would want to
break in to your home computer? The crackers
who do try to break in don’t know if your com-
puter is an important one until they get inside.
Their typical attack is to try a single vulnerability
on every computer they can find. These attacks do
not discriminate as to how important the target is.
They attack everything in sight.

ATTACK CANDIDATES
If your computer is hooked up to the Internet via 
a Cable/DSL router (NOT a Cable/DSL modem—
there is an important difference), it is likely that
your system is already very secure. The most
important factor in this case is that you configure
your Cable/DSL router properly. Unfortunately,
older routers were designed with poor default 
configurations and opened up systems to attack.
So if you have an older router and have not recon-
figured it properly, it will not protect you from
attacks. Fortunately, most new routers on the mar-
ket today are configured to be secure by default.
Linksys, NetGear and many other companies make
decent routers that are generally secure by default.
Watch out, however, if you choose a router that

includes wireless capabilities. A router that supports
wireless clients makes computing very convenient,
but you may be opening up yourself to attack once
again unless you configure your router properly.
That is a topic for another article, however.

If your computer is hooked up directly to
the Internet through a Cable/DSL modem or a
regular phone modem, you can assume your
machine is under attack continually. This is
where a firewall is important and why it should
be turned on by default. By studying the logs
that my firewall creates, I have found that my
firewall typically stops more than 1,000 attacks
a day. This is a residential DSL connection. My
firewall is the only defense standing between
me and the innumerable attackers on the
Internet. I wouldn’t be without it.

The default firewall policy on most Linux distri-
butions is to let all data requests out and let the
reply to those data requests back in, but to deny
any data packets that were not answers to our
requests. What that means is that we can use the
computer to access the Internet, but anyone who
is attacking our machine from the Internet gets
cut off. That’s good, right?

It’s good, but it’s not as good as it could be. It
would be better if we could tell the firewall what
we expect to be doing so that it can allow only
those things to happen on our computer.

Let’s talk about three scenarios so you can
understand where we are going:

1. There is no firewall. All data packets are
allowed in and out.

2. There is a firewall that is blocking uninvited data
but allows us to do anything on our computer.

3. The firewall is controlling everything that goes
in and out.

Scenario 3 is better known as a default block
all policy. If we don’t teach the firewall some
rules under this scenario, we might as well
unplug the cable to the Internet. Unfortunately,
the rules to implement such a firewall are
tedious and complex. More good news—there
are tools to make this easy to accomplish!

I use Guarddog for KDE to configure my firewall.
Guarddog eliminates the difficult learning required
to implement this type of firewall by making some
assumptions and calling things what they are in
plain English. We’ll continue next month with an
installation of Guarddog and a thorough explana-
tion of how to use it to configure your own firewall
for even more security than the default installation.

In the meantime, if you find this topic inter-
esting, you might want to read the Linux Security
How-To that has been growing for many years
(http://www.linuxsecurity.com/docs/LDP/
Security-HOWTO). It is a collaborative effort of
many security experts that want you to have a
secure computer. There is a lot of good information
here for new Linux users, and if it gets too steep,
don’t worry about it. Those same people have been
working on making Linux more secure before you
ever installed it.

See you next month.�

Phil Barnett is a Senior Programmer-Analyst at Walt Disney
World where he has spent the last ten years working with cor-
porate software and computer security projects. Six years ago,
he helped incorporate the popular Florida Linux User Group,
Linux Enthusiasts and Professionals, which he considers his
greatest Linux accomplishment (http://www.leap-cf.org).
Besides Linux and computers in general, his other hobbies
include woodworking and amateur radio communications.
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TUX is all about using Linux now—not by sea-
soned, professional computer nerds but by every-
day users with everyday tasks. TUX is for people
who use Linux like they use their DVD players.
They don’t want to ask why it works. They want
to know how to make it play.

So this month, I dug around a little to see
what sort of questions and comments were being
made about GIMP on various discussion forums
about making GIMP play. There are actually quite
a few places people talk about GIMP, and not all
of those places are specific to GIMP users.

One interesting question came from a husband
trying to get his wife to use GIMP for scrapbook-
ing. He wanted to know how to use GIMP to
solve scrapbooking problems: layout, fonts, back-
grounds and so forth. What struck me as odd was
how many people responded that GIMP was not
easy enough to use for scrapbookers and that he
probably should look elsewhere.

Hogwash.
I’m going to show you how GIMP easily can

cover any of the issues you have with scrapbook-
ing. The problem won’t be how to get GIMP to
play—it will be how to get yourself to stop playing!

Requirements for this tutorial: it would help if
you already have a little familiarity with the GIMP’s
Toolbox and the Layers dialog, but it’s not
required. Digital cameras or scanners help to get
images into GIMP, and a recent Linux distribution

such as Red Hat/Fedora, SUSE/Novell or Mandrake
with all the bells and whistles installed also will
make your life easier. To make this all worth while,
you need to have your printer configured as well.

PROBLEM 1: GETTING IMAGES
If you’re working with pictures developed the old-
fashioned way, you need a scanner. Scanners are
supported with the SANE package and the XSANE
plugin for GIMP. Both are included in all modern,
popular Linux distributions. A scanner connects to
your computer in one of three ways: via the paral-
lel port, via a SCSI connector or via a USB connec-

tor. Only very old scanners use the first two. Most
modern scanners offer USB connectors.

To use your scanner with GIMP, look in the
GIMP Toolbox under the File→Acquire menu. If
scanner support is properly configured, you’ll find
at least two options: one for the generic XSane
interface and one for each scanner found con-
nected to your computer. You’re unlikely to need
the generic option—it’s for more advanced use.
The other option opens a window that lets you
preview what you placed on the scanner, select
parts of those images and then scan them.

With scrapbooking, you’re going to want to
print out images after you have modified them
to your tastes in GIMP. You should scan them at
a reasonable DPI so that the picture will look

SSccrraappbbooookkss  aanndd  AAllbbuummss
How to use GIMP for popular image tasks like scrapbooking.

MICHAEL J. HAMMEL

Figure 1. XSane Interface, Acquire
Menu Figure 2. DPI Setting
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good. DPI means dots per inch. Without getting
too technical, you simply need to remember to
scan with the DPI setting of at least 150. A DPI
setting of 200 or 300 would be even better, but if
your computer has limited memory (something
less than 500MB), 150 will do. Once scanned, the
image will appear in a GIMP canvas window.

Scanners are cheap these days, primarily
because a better way has come along: digital
cameras. GIMP also supports digital cameras via a
plugin from the Gtkam Project. In order to use
your camera, make sure you have gphoto2, libexif
and libusb installed. Again, these are likely to be
installed already or easily installed with your distri-
bution’s software installation tools.

PROBLEM 1: ADDING BACKGROUNDS
After retrieving your images, you’re ready to add
some personal touches. Like scrapbooking, GIMP
works by layering elements. The images just
scanned will be copied into a new canvas window
and positioned over a background.

I’ll start by by opening a new image window
(File→New from the Toolbox) and choosing a
common page size, in this case the US Letter tem-
plate. Then, under Advanced options, I’ve set the
X and Y resolutions to 150 and made sure the
window uses the current background color (which
I’ve not changed from the default of white).

Clicking OK opens the new, white canvas window.
The scrapbook page is ready to be filled.

Now I can add a background. GIMP comes
with a wide selection of backgrounds (and creat-
ing new backgrounds requires only that you save
any image in the PAT file format—see File→Save
As). For simplicity’s sake, I’ll choose one of the
stock backgrounds, Terra, by clicking on the
Pattern icon in the Toolbox and choosing the Terra
background tile. I click on the Bucket Tool in the
Toolbox to make it the active tool, set this tool to
use the selected pattern and then click in the new
canvas I just opened. The pattern fills the page—
Problem 1 easily solved!
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Tool Options
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PROBLEM 2: FAKING MATS
Next up is a little fakery—I’m going to put borders
around the image that make it look like it lies
beneath a cardboard mat.

First, I drag the scanned or digital camera
image into the background. In the Layers window
(with my scanned image displayed—check the
menu button at the top of the Layers window), I
click in the image icon, holding down the mouse
button and drag the mouse into the window I just
filled with the Terra background. This creates a
new layer. See the Layers window? It shows two
layers now. The scanned image will be the active
layer (it is highlighted in blue in the Layers win-
dow). If it isn’t active, I simply can click on the
layer name to make it active.

Now I’ll select the entire photo
(Layer→Transparency→Alpha to Selection). I click
on the Rectangular Selection tool in the Toolbox
and set the Subtract Mode. Then I drag another

selection inside the first. The Subtract mode
means “cut out this new selection from the old”,
which leaves an unfilled border. You have to hold
the Ctrl key down when you start to drag, but let
go of it right after that and before you finish
dragging, otherwise you can’t draw a selection
inside an existing selection.

I add a new layer (Layer→New) and click on it
in the Layers window to make it active. Clicking
on the foreground color lets me choose another
color for the border. I want a brownish color, so I
type B3661A in the HTML field. Granted, this is
the stuff of guru magic, but it’s not that hard
once you get used to it. The number contains
three color values. Each color value can be any-
thing from 00–FF (this is a hexadecimal number).
Here is how you count in hexadecimal: 0, 1, 2, 3,
4, 5, 6, 7, 8, 9, A, B, C, D, E, F. So you mix colors
by selecting a combination of hexadecimal num-
bers, in this case, the red, green and blue color

combination is B3, 66 and 1A, respectively. The
higher the number, the brighter that color will be
in the mix. If you want black, then use the num-
ber 000000. If you want white, use FFFFFF,
because that will set all the colors to the very
brightest, which makes white.

You can select colors in many ways in this win-
dow—play with it a while to get the feel of it—
but if you know the color by its RGB values, you
can type them in where appropriate. I click OK to
close the window and then drag the foreground
color into my selection to fill in the border.
Pressing Ctrl-Shift-A gets rid of the selection.

To simulate the edges of the cardboard mat, I
first click on the Fuzzy Select tool in the Toolbox.
Then I click inside the border I just made. A new
selection shows up that matches the inside edge
of the border. Reset the foreground/background
colors by clicking on the little boxes in the lower-
left corner of the Toolbox. A new layer is added
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Figure 6. Layers Dialog, Dragging One Image into
Another

Figure 7. Border Creation
Figure 8. Fuzzy Select Tool, Stroke Window, Border
Edges, Layer Offset
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(Layer→New), and the selection is stroked
(Edit→Stroke) using the default settings in the
window that opens. This layer is duplicated
(Layer→Duplicate), and the colors are inverted
(Layer→Colors→Invert, which gets you a white
border). Offset this new layer by -1/-1
(Layer→Transform→Offset).

Click on the Eraser tool, choose the Circle
Fuzzy (76) brush and erase the top and left side of
the white border. Set the white border layer Blend
Mode to Grain Merge.

This one was a little more complex, but not
much. Erasing the white border will probably be
your toughest task because it’s a fairly manual
process. But once you master this, Problem 2 
is solved!

PROBLEM 3: ADDING SPEECH BUBBLES
Most scrapbooking adds text to an image in some
way. A quick search with Google shows that a
common layout is to use little boxes below or to
the side of an image. We can go one better, very

easily—a speech bubble.
A new layer is added. In this layer, I draw a

rounded selection using the Elliptical Selection
Tool. I then select the Free Select tool from the
Toolbox and set its mode to Add. I click and drag a
triangle shape starting below the bubble, up into
the bubble, to the right and back to near the start-
ing point, then release the mouse button. This
adds the triangle shape to the round selection.
Dragging the background color (white) into the
bubble fills it. Pressing Ctrl-Alt-A at the same time
removes the selection so I can see the bubble.

Text is added to this bubble using the Text tool.
I used the Sans font and 70 pixels size. Clicking in
the canvas window opens an editor that allows
adding the text. The letters are drawn in the can-
vas at the same time you type them. The text
won’t be placed in the bubble automatically. In

fact, it might not even all fit on the screen initially.
I’ll position the text in a moment. If you find the
text is too big after you move it into place, click
on the text again with the Text tool active to
change the size.

PROBLEM 4: POSITIONING ELEMENTS
The Move Tool is used to drag all the elements
around the scrapbook page. We made the mat fit
directly over the image so we can move all those
elements at once. In the Layers dialog, click on
the anchor icon (Figure 11) for each layer we
want to move as a single piece. Make sure the
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Figure 9. Elliptical Selection, Free Select and Options
Modes, Filled Bubble Figure 11. Move Tool, Layer Anchors

Figure 10. Text Tool, Options and Editor, Filled Bubble
with Text
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Move tool is active in the Toolbox, then hold
down the Shift key and click and drag inside the
canvas window. If your computer has limited
memory or a really slow processor, moving big lay-
ers like this might be a little slow. But hey, that
would be true with other programs on other
operating systems trying to do this same project,
so don’t blame GIMP for that!

Be sure to have one of the anchored layers
active in the Layers window (it will be highlighted
with blue) before you try to move the bunch.
Moving an individual layer is done the same
way—with the layer active—but without any
anchors turned on. To turn off an anchor, simply
click on it.

Positioning elements is a personal touch that
is a major part of the whole scrapbooking hobby.
There are tools in GIMP for positioning elements
exactly (see Layer→Align Visible Layers) and
external plugins for doing it more interactively
(see the Graphics Muse Tools GFXLayers plugin,
for example) but these probably aren’t necessary
for projects like scrapbooking.

PROBLEM 5: PRINTING
Your work of art is ready for the scrapbook.
Now you need to print it. All Linux distributions
provide tools for configuring a printer. As long
as your printer is configured, all you need is the
GIMP-Print plugin. If you have the File→Print
menu option, you should be set to print.

Printing for scrapbook projects is a talent unto
itself because the real personal touch comes from
the selection of papers. GIMP-Print can handle
pretty much anything your printer can, so you
need do only a little research into the types of

papers your printer can handle. This means more
than just different page sizes; it also means print-
ing on canvas, jerseys, bumper stickers or any
other odd type of paper. The limit will be in your
printer—not with GIMP!

This project is just an example of how GIMP
can be used for scrapbooking. Experienced
users will find that you don’t often print the
whole project on a single sheet of paper, but
rather print elements one at a time on different
types of papers. Though you might print the
elements separately, the basic process remains
the same.�

Michael J. Hammel is an author, graphic artist, Web designer
and software developer currently working for RLXTechnologies
in Houston, Texas. He has spoken at the ALS, LinuxWorld and
SXSW conferences, and chaired multiple conferences on Linux
in Colorado. He is the primary maintainer for the MiniMyth
build system, and he runs XEUS, his own development site for
XNotesPlus, Ximba Radio and other open-source software. He
can be reached at mjhammel@graphics-muse.org, and his blog
is at http://www.ximba.org/wordpress.
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Figure 13. Final Image
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Qt (pronounced “cu-tee” or “cute”) is the C++
application development framework that forms
the basis of KDE, the K Desktop Environment,
and it is used by Linux applications such as
Scribus and Skype. It is developed by Trolltech,
a Norway-based software company whose
product line is centered around Qt. Although
Qt mainly focuses on GUI (graphical user inter-
face) functionality, it also provides excellent
support for various programming domains,
such as internationalization, networking, multi-
threading, SQL and XML.

From day one, Qt was a fully object-oriented
cross-platform toolkit, with support for both
Linux/UNIX and Windows. In 2000, Trolltech
released Qt/Embedded, which was designed to
run on embedded Linux devices and provided
its own window system as a lightweight alter-
native to X11. And with the release of Qt 3.0
in 2001, support was added for Mac OS X.

WHO CAN USE QT?
Trolltech’s business model, based on the idea of
dual-licensing, works as follows:

� Developers who want to give away their
source code to the Open Source community
can use the Open Source (GPL) edition.

� Customers who make money on their soft-

ware or use it in a commercial context must
purchase a commercial Qt license.

The Open Source edition is first and fore-
most a gift to the Open Source community.
Many developers at Trolltech have their roots
in that community, and most of them use
open-source and free software every day to
do their work.

From a Linux perspective, it means that a
high-quality professional tool, developed by a
dedicated team of paid developers and used by
thousands of paying customers, is available for
open-source software development. What’s
maybe less obvious is that Qt’s single source
approach to cross-platform development 
and its dual-licensing model accelerate the
migration of Qt-based commercial Windows
applications to Linux.

A BETTER MFC THAN MFC
Although Qt is cross-platform, many companies
use it for single-platform development. These
companies use Qt because they find the Qt API
(application program interface) superior to that
of the Windows-specific toolkits. They also find
that Qt insulates them from differences in the
Windows APIs. For example, with Qt, the same
executable works on Windows 95 to XP; Qt
performs a check at runtime and uses the most

WWiinnddoowwss--ttoo--LLiinnuuxx  MMiiggrraattiioonn  wwiitthh  QQtt
Combine the power of Qt with the ability to write one application that runs on Windows, Linux and Macintosh, and you get a bright future for Linux on the desktop.

JASMIN BLANCHETTE

Editor’s Note
This article was written by an employee of Trolltech,
the company that sells and offers free versions of
Qt. We do not usually print articles written by ven-
dors, as it poses a potential conflict of interest. In
this case, we gave Trolltech specific guidelines on
how to approach this topic in order to prevent the
article from being an advertisement. Trolltech came
through for us. Yes, the article promotes Qt, and Qt
is worthy of being promoted. But our purpose in
commissioning the article is to illustrate that Qt
enables people to write a single application for
multiple platforms (Windows, Linux, Macintosh and
more). This makes it possible to create applications
with the widest audience possible. It also means
that Linux can reap the benefits if someone uses Qt
to write an application for Windows or Macintosh,
because it is a fairly simple process to recompile
the application to run on Linux.

In fairness, other cross-platform solutions are
available, such as wxWidgets. In addition, you 
can always write applications in Java that are 
platform-agnostic. But we know of no other 
multiplatform solution that is as comprehensive
and self-contained as Qt, so we find it a worthy
exercise to examine how people have used Qt and
look at its advantages, because this information
should be very encouraging to Linux desktop users.
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advanced capabilities available. Microsoft’s library
of tools for the Windows API is called Microsoft
Foundation Classes (MFC). With MFC, this is not
possible without creating two executables.

Rowley Associates based their CrossStudio IDE
on Qt/Windows. They have now ported their
application to Linux at the request of some of
their customers. The port was done by a developer
who had no previous Linux/UNIX experience and
took only a couple of days, showing how easy it 
is to transform a well-written Windows Qt appli-
cation into a native Linux application.

TOOLKIT CONFUSION ON WINDOWS
Microsoft has practically given up MFC and is
preparing to replace its successor, Windows
Forms, with the Avalon framework. The uncertainty
surrounding these three APIs has alienated many
Windows developers, who are now looking at Qt
as a more stable alternative.

JMP, a division of SAS, who previously used
MFC in statistical data visualization software,
found themselves in that situation. JMP software
is widely used in industrial companies, notably
Dow Chemical, Honeywell International and
Aventis Pasteur.

Richard C. Potter, Senior Software Manager at
JMP, summarizes the search for an alternative to
MFC as follows: “We needed to find a class library
that would be compatible with our existing archi-
tecture. We briefly considered using GTK+, but we
quickly realized that it would not be acceptable.
Qt was a better fit with the existing architecture
of our product. Since Qt classes match closely
with those in MFC, converting our existing 
MFC-based source code into Qt-based source
code was straightforward.”

Another example is Firstlogic, which provides

customer relationship management (CRM) solutions
to more than 6,000 businesses around the
world. When they set out to develop IQ8, their
next-generation data quality solution, they decided
to move away from MFC to Qt because they needed
a more modern and flexible toolkit. Now, IQ8 is
available for Linux and commercial UNIX systems.

HOW MAC OS X IS HELPING LINUX
Although the uncertainty surrounding Windows
Forms and Avalon is an important factor playing in
Linux’s favor, another factor is that software com-
panies increasingly need to target both Windows
and Mac OS X. They choose Qt because of its
cross-platform capabilities.

BMPi, the interactive version of “Birds of the
Western Palearctic”, developed by Skylark
Associates, is such an application. Other examples
include PerfectTablePlan by Oryx Digital and
Mindawn by theKompany.com. As Linux becomes
more popular as a desktop platform, the providers
of these cross-platform applications are likely to
port their software to Linux as well as Mac OS X.

THE OPEN-SOURCE FACTOR
Interestingly enough, many companies consider
the existence of an Open Source (GPL) edition of
Qt as an advantage over other toolkits.

For them, this means that the product is widely
tested by hoards of open-source software users,
including KDE users. Mailing lists, on-line forums,
books and certain components (for example, the
Qwt plotting library) are available on the Internet
to both open-source and commercial developers.
Finally, when it comes to hiring, there is a large
talent pool of open-source developers with Qt
skills out there.

About this topic, Rainer Goebel, who is Chief

Software Designer at Brain Innovation, a company
that migrated from MFC to Qt, says, “We ended
up choosing Qt due to its consistent object-orient-
ed approach combined with its elegant signal-slot
mechanism. The knowledge that Qt was used to
develop KDE, one of the two major Linux/UNIX
desktops, also helped in the decision process.”

THE FUTURE
Even though Qt was originally designed as a cross-
platform GUI toolkit, there is an increasing number
of companies who adopt Qt for single-platform
development on Windows, rather than Microsoft’s
half-baked solutions. With the emergence of Linux
on the desktop, these companies will be in a posi-
tion where they can port their applications to
Linux in very little time, which in turn will help
user adoption of Linux. It also may be noted in
passing that Qt is helping Linux adoption on
embedded devices. Qtopia, Trolltech’s application
suite for smart phones and PDAs, is based on
Qt/Embedded, which in turn is based on Linux.

With the growing popularity of Linux and Mac
OS X, companies are becoming increasingly con-
cerned about portability, even when they have no
immediate plans to port their applications. They
don’t want to be locked in to an unsupported
technology, such as MFC or Windows Forms, and
prefer to turn to a widely used and actively devel-
oped cross-platform toolkit. For many of them, Qt
is that toolkit.�
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manager at Trolltech AS in Oslo,
Norway. He takes pride at being
Trolltech’s only Swedish-speaking
French Canadian. You can reach him 
at jasmin@trolltech.com.
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There are plenty of popular distributions
of Linux you may have heard about. But
there is also a lesser known distribution,
Libranet, which takes a different
approach to the desktop than most
other distributions. Rather than assum-
ing that new users need something that
looks completely like Windows, or that
all of the tools need to be customized,
the folks who produce Libranet apply
their efforts and innovation to plug
holes where they exist and to present
more of a standard and seamless 
desktop. We take a look at their latest
release, 3.0, and see whether their pre-
vious history of innovation stands up.

INSTALLATION
Unlike the previous version, 2.8.1, 3.0
starts and configures the X Windows
System (X) as soon as it can. This makes
the whole installation process a lot nicer,
as you can turn the screen resolution up
or down right away and not be forced
to work in an awkward, small space (as is usually the
story with any OS installation). Another added bonus
is that the X Windows System is all ready to go
when you load it up—no changes necessary.

The X configuration is fantastic. I already was
using my accelerated video drivers before it even
started! Once in the configuration screen, I was able

to choose which options I wanted for screensavers
and resolutions, and I even could change around
which driver modules to load. There is another nice
touch—Libranet offers widescreen resolutions for
those who have widescreen monitors. To put it sim-
ply, I was chuffed with the X configurator, and I
haven’t seen any other like it—Libranet was certainly
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John Knight gushes over the latest release of Libranet Linux.

JOHN KNIGHT

GNOME 2.8 Running
OpenOffice.org

Libranet 3.0
Features:

• Kernel 2.6.11

• KDE 3.3.2

• GNOME 2.8

• Xfce 4.0.6

• OpenOffice.org 1.1.3
(Debian version)

• Firefox 1.0.2
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off to a great start!
Next came the partitioning of the hard disk. This is usually

where most beginning Linux users feel as if they’ve entered
the Twilight Zone and have no idea how to approach the
process. Libranet was adequate in handling this but not
amazing. Some of the warning messages were off-putting
and a touch misleading.

The next few configuration screens were nice. The net-
work setup has nicer GUI options, and it is better than the
old text-based installer. The bootloader options, which let
you decide how to boot Linux on your computer, were fan-
tastic. Libranet gives you not only a choice to make a boot
floppy, but, get this, it lets you create a boot CD. The
installer actually includes a small CD-burning application.
Take notice distribution vendors, floppies are obsolete, and
this kind of innovation is the way of the future.

The process for selecting the software you want to install
is a little longer with this version than it was with the previ-
ous release of Libranet, but this is due to a large increase in
the amount of packages available. This also varies, depend-
ing on how many CDs you download. Libranet comes on
1–5 CDs or a single DVD, so the choice is yours as to how
comprehensive you want to make your Libranet system. The
package selection is very advanced with extensive choices for
multilingual dictionaries and GUI (graphical user interface)
components. This is probably because Libranet is based in
Canada, a multilingual country in itself, which makes it easier
to pay attention to users’ needs.

Once you begin installing packages, beware. You have a
one or two hour wait ahead of you. Version 3.0 includes a
progress bar, which was missing in 2.8.1. In the old version,
the installation times remained a complete mystery. Once the
packages are installed, the process is finished and you are
ready to reboot into Libranet Linux. Strangely enough, there
didn’t seem to be any sound-card configuration steps. Sound
simply worked when I rebooted. This can have its ups and
downs, but in the end, it’s nice to have hardware that simply
works with no configuration.

UP AND RUNNING
Once you reboot, Libranet greets you with some nice intro
screens. The first praises the efforts of the Open Source com-
munity, the next explains the login process and the last tells the
user about the program called Adminmenu, all of which are
very useful to new computer users. Once you reach the login
screen, the default choice of your desktop is called Libranet.
You are free to choose from a number of different window
managers, including KDE, GNOME, fvwm, Afterstep, IceWM,
BlackBox, Openbox, Xfce, WindowMaker and fluxbox.

The default Libranet session uses a modified version of the
lightweight desktop IceWM and adds the Nautilus desktop
and file manager used in GNOME. This gives users a fairly
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“Windowsy” feel. The relative simplicity of IceWM allows the
Libranet folks an easier way to customize the desktop with-
out having to modify the more complex KDE and GNOME.
The Libranet desktop has its own charms but is fairly utilitari-
an in looks and function; for most users, I would suggest
sticking with KDE or GNOME.

KDE users are catered to with KDE 3.3.2. This is not the
current bleeding-edge release of KDE, but it is still the most
recent stable release. KDE simply has had a few icons added
and its desktop background changed. The change of back-
ground is probably for reasons of continuity, but for aesthetic
reasons, feel free to change it to something else. The includ-
ed KDE isn’t too crippled and behaves itself stability-wise, but
unfortunately, KDM still is not included as an alternative to
GDM (KDE and GNOME’s login managers).

As for GNOME users, GNOME 2.8 is included, and again,
the only real changes are the desktop background and some
icons to the Adminmenu and so forth, which are more useful
than invasive. So in the end, GNOME users shouldn’t be too
angry either.

The new 2.6 kernel makes desktop responsiveness very
snappy too; even with all of the default background services
running, window and menu reaction time still was fast.

SOFTWARE
Libranet always has been known for a great software collec-
tion for the desktop, and they’ve yet again surpassed them-
selves with this release. Fancy some office work? Fire up
OpenOffice.org. Web browsing is bleeding-edge with Firefox
1.0.2 (at the time of writing this anyway), and if for some rea-
son you prefer its older brother, Mozilla 1.7.6 is also included.
In fact, simply looking at the Internet menu is overwhelming;
whatever niche tool you’re looking for, it’s probably there!

Libranet really shines when it comes to multimedia. I was
thinking of providing a list of the available applications, but
there’s far too many. For audio playback, take a pick of many
players, but for some more interesting choices, how about
amaroK? Or Beep, a neater, simpler remake of XMMS?

Perhaps JuK takes your fancy? Fancy editing audio? KWave
Sound Editor, Audacity and GLAME are provided, among oth-
ers. What about making music? Try BEAST, Ardour or brahms.
By the way, do you have an iPod? No problem—try gtkpod.

But that’s only audio; the video side of things certainly
isn’t lacking either. MPlayer is included for advanced video
playback, along with the usual Totem, plus RealPlayer 10 to
top things off. Libranet really has made an effort with DVD
playback, and it provides a number of different applications
available to suit your tastes: Xine, Ogle, oKle and, of course,
MPlayer if need be. You also can do your own video editing
with Kino. There are even some TV-tuner applications.
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When it comes to CD/DVD burning,
Libranet really shines again. You have a
choice of K3b and GCombust. Normally,
it takes a lot of setting up to get CD
burning to run properly, let alone DVD
burning, but K3b simply ran properly
without needing my intervention. I
couldn’t believe I didn’t have to do a
thing! Of course, playing encrypted DVDs
didn’t work, as most distributions (if not
all) avoid it for legal reasons. But all you
have to do is find and install libdvdcss to
get all the DVD players working. All in all,
this is one of the coolest software compi-
lations around, and I challenge you to
find a better one for desktop needs.

ADMINMENU
The Adminmenu is the core of Libranet.
Most distributions have a central selec-
tion of software for system administra-
tion, but Libranet has unique kernel
functions that are unmatched. Libranet
makes compiling a Linux kernel easy. In
the past, it used a text-based program,
which was quite easy to use, but now
things have moved onto a full-blown
GUI; it’s just as easy to use as before,
but it has added features for managing
different kernels. If you don’t know
what you’re doing, simply run with the
defaults and choose your processor
type; otherwise, tweak away!

Libranet has added a number of new
applications, removed some and updated
others. The biggest change in this new
version is that Libranet now splits the
Adminmenu into two parts: the standard

Adminmenu and the User Adminmenu,
which has single-user-specific options
that don’t require a root password like
the normal Adminmenu. The changes to
the Adminmenu are not unwelcome,
and there certainly are some pleasing
improvements. The Adminmenu still
deserves the reputation it has, and it
helps make this distribution unique.

BRICKBATS
No distribution is perfect though, and
Libranet has its share of faults. CDs
often refuse to eject for no apparent
reason, yet they unmount fine. It seems
to be a problem with HAL (the hardware
abstraction layer—something you
shouldn’t need to fiddle with). Think of
HAL as a driver/device middleman.
When I disabled it, suddenly my DVDs
ejected fine.

Libranet doesn’t set up Windows
partitions automatically. New users sim-
ply won’t know what to do in this case.
Libranet needs to add an application in
the Adminmenu to let users scan for
Windows partitions and then automati-
cally set them up for use.

I also experienced problems with
the multimedia application gstreamer.
Some applications work around prob-
lems and other refuse to run, so you
may have to get a Linux guru to do
some post-install tweaking. If you are
an amaroK fan, simply change the
sound engine from gstreamer to aRts,
or else it will complain about not
being able to play MP3 files.

SUMMARY
Although there are a number of flaws,
there are so many huge innovations
with this distribution that it simply can-
not be ignored. Hard-core Debian nerds
may not see the benefits, but desktop
users should be pleased. Network
administrators won’t find much pleas-
ure here either, as this is clearly a desk-
top distribution. But typical
desktop/multimedia users will have a
field day, as Libranet is easily one of the
strongest choices available, if not the
strongest. One can always expect flaws
in any x.0 release, and with 3.0 as a
framework, the next release promises to
be unstoppable.

I personally recommend the Libranet
series to most new users as it presents
standard tools and standard desktops
with some added extras, rather than
trying to lock users in to their own way
of doing things (which makes changing
distributions very difficult). Innovation
is clearly shown with the CD/DVD
burning that simply works without tak-
ing any prior steps, along with a num-
ber of areas system-wide that simply
work without the user knowing a
thing. Libranet is a shining example of
how Linux desktops are already great
without the need for heavy modifica-
tion and that the makings of a good
distribution are simply hard work and
elbow grease.

Libranet is, in one word, awesome.�
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One thing’s for sure: with the explosion of
multimedia files, from MP3s to photos to
video, the need for storage is growing like
crazy. That old 20-gigabyte hard drive you
got with your computer is now positively
bursting at the seams, and the 128-megabyte
MP3 player you thought would be your best
friend forever is just so...small.

As we become more multimedia-hungry,
we need bigger and bigger hard drives,
both for our home computers and for our
portable gadgets. Here’s a pair of Linux-
friendly gadgets with hard drives inside.

PALMONE LIFEDRIVE MOBILE MANAGER

http://www.palmone.com
$499 US

Palm still rules the roost when it comes to
organizers, and with the last few Tungsten models,
the Palm’s multimedia abilities have gotten pretty
snazzy. The biggest problem, though, is not
enough storage! For anyone who wanted to
watch videos or store more than a handful of MP3
files or photos, it was absolutely imperative to
invest in some high-capacity SecureDigital cards.

No longer. The new LifeDrive Mobile Manager
comes with a four gigabyte mini-hard drive built
right in, which means plenty of storage space for
photos, music files and video. (It’s the same
amount of storage you’ll find on the smallest iPod
Mini models, in fact.) There’s still a SecureDigital
slot on the top of the LifeDrive, allowing you to
view the images from your digital camera, swap
files with your friends or offload files to make
more space on the drive.

The LifeDrive is also the first member of the
Palm family to feature both of the major wireless
technologies: in addition to Bluetooth connectivi-
ty, the LifeDrive also comes with 802.11b Wi-Fi,
which means you can get access to the Internet
from any wireless hotspot.

Like the Tungsten T5, the LifeDrive has an
excellent reflective screen, with a resolution of

320 x 480 pixels.
Like that previous
model, the Graffiti
pad is virtual.
Rather than print-
ing it right onto
the plastic, it
appears as com-
puter graphics;
when you tap an
icon on the screen,
the Graffiti pad
disappears, allow-
ing you to use
more of the screen
for photos or doc-
uments. There’s
also a Rotate
Screen button

along the left-hand side of the LifeDrive for 
one-touch switching between portrait and 
landscape mode too. Simply tap the button if 
you want to watch a video or want to view your
spreadsheet horizontally.

If you’re running Linux, Palm’s handhelds are
more fully compatible if you download/install the
latest utilities (KPilot, for example). If you can’t
be bothered with installing and configuring the
proper applications, there’s still a quick and easy
way to get your files and applications onto 
the LifeDrive.

Like the T5 before it, the LifeDrive features an
icon marked Drive Mode. Once you tap the icon
and turn on drive mode, you can plug the
LifeDrive in to any computer, and it will act as an
external hard drive. You can then drag and drop
your multimedia files directly into the appropriate

Gadget Guy:
Products with
Drive
SEAN CARRUTHERS

http://www.palmone.com
http://www.tuxmagazine.com


folder on the LifeDrive. There’s even a folder for
applications, meaning you can drag and drop
Palm applications instead of being forced to
HotSync them onto the device. All files that you
drag to the LifeDrive in this manner—whether
multimedia or applications—are then accessible
from the Files icon on the LifeDrive.

You also have the option of installing new
applications to the LifeDrive over the Web. If you
click on the application file when you’re at a Web
page, the LifeDrive gives you the option of
installing it directly to the device. You certainly
could do this with earlier models like the Treo
600 (via cellular) or the Tungsten T5 (via
Bluetooth), but with the addition of Wi-Fi wireless
networking to the device, this process is faster
than ever before.

A few things aren’t perfect, however. First of
all, as with the majority of Palm devices, the
battery is locked firmly inside the LifeDrive. In
other words, when the battery inevitably needs
replacing, it’ll mean a service call.

Second, you’ll want to be very sparing with
your use of the wireless networking, because the
Wi-Fi component really sucks back battery power.
You can get reasonable runtime between charges
when you’re not using wireless, but with Wi-Fi
on, you can use up your entire battery charge in
a few hours.

If you’re planning to go easy on the wireless,
you’ll probably be fairly happy with the
LifeDrive’s multimedia capabilities. That’s espe-
cially true if you have a bundle of photos to
show off to friends and family. In addition to all
the usual Palm capabilities like calendar and
address book, the LifeDrive also handily doubles
as a great digital wallet.

SEAGATE 400GB EXTERNAL DRIVE

http://www.seagate.com
$350 US

It doesn’t
matter what kind
of operating 
system you
have—Linux,
Windows or
Mac—eventually
you’re going to
run out of hard
drive space.
Thankfully, a
growing number
of high-capacity
external hard

drives are compatible with all of the aforemen-
tioned operating systems, and they also make it
easy for you to move files between them, if you’re
a multi-OS household.

Seagate’s newest external drive is a whopping
400 gigabytes, which works out to about 6,400
hours of music, or around 400 hours of digital video.

The drive actually comes in two versions. The
storage-only version comes with a USB 2.0 connec-
tion for fast transfer to the computer. There’s also
a push-button backup version that launches back-
up software on a PC or Mac when you press the
button on the front panel; it features both USB 2.0
and FireWire 400 connections to the computers.

The drive should be compatible with most up-
to-date versions of Linux. Simply plug it in, and it
should appear as a removable drive.
Unfortunately, the included backup software
won’t work with Linux, so you’ll have to settle for

a more primitive drag-and-drop form of data
backup, unless you’re ready to start configuring a
Linux-friendly backup package.

The drive is designed to sit in either vertical or
horizontal orientation. A rubber ring along one of
the long sides of the drive casing is designed to 
sit on your desktop, but it also tucks nicely into a
circular indent on the opposite side of the casing,
if you want to stack multiple drives. (The form 
factor is coincidentally almost identical to the Mac
Mini, by the way; if you’ve got a Mini in the
house, they stack beautifully.) For those that pre-
fer to stand it upright, there’s a clip-on plastic
stand that attaches to one of the small ends.

One of the nicest things about this drive is its
power management. First of all, it has a power but-
ton, which is more than you can say for some of the
competing products out there—when you really
don’t need the drive, you can flick the switch. If you
forget to turn it off between uses, though, the drive
electronics stay on, but the drive inside powers
down, which means you won’t torture your loved
ones with the high-pitched whine of the drive
spinning all night long if you forget to shut it off.

All of these things add up to a winner. No
matter which computer you’re planning to use it
with, the 400GB Seagate drive is a great choice.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB
Digital Living, Computer Dealer News,

Homefront and CE-Biz. Although a relative newbie with Linux
(SUSE, thank you very much), he has extensive experience with
tech gadgets of all sorts and is enjoying figuring out which ones
are compatible with Linux.
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Over the last few years, software-
based firewalls have become more
and more accessible to Linux users as
a way to secure their systems against
potential malicious attacks.

Major OS makers, such as
Microsoft and Apple, as well as Linux
distributions, such as Red Hat or
SUSE, started building simple inter-
faces for enabling and configuring a
basic firewall on personal computers.

Guarddog is a very powerful firewall
configuration system that offers sup-
port for Linux firewall facilities, such as
ipchains/iptables, and provides you with
a fine-grained configuration system.

The initial dialog allows you to
configure network zones for your
network interfaces (in most cases,
the default settings in this section do
not need to be altered).

The second section of the user
interface is the main firewall configu-
ration dialog. It provides you with a
rather complete list of network proto-
cols sorted by category. Clicking on a
specific protocol display provides you
with information such as risk level and
a description of the protocol and ports
used by the protocol, and marking the
check box associated with a protocol
allows connections for that specific
protocol through your firewall.

Guarddog also allows you to

specify a logging policy for your fire-
wall to maintain a journal of network
events worthy of attention, which
lets you identify problems with your
configuration or perform audits in
case of an intrusion of your system.

The Advanced section provides an
interface to create custom protocols
based on port ranges, transport-layer
protocols and a description of the pro-
tocol, but it also lets you turn off the
firewall completely or import/export
Guarddog configuration files from/to
other computers.

Another important aspect of the
application worth mentioning is the
excellent (alas, often ignored) docu-
mentation provided with the applica-
tion. The Help file, titled the Guarddog
Handbook, is well written and offers a
walk-through of the application, includ-
ing the complete setup of a fine-tuned
firewall facility from the ground up.

If the Help file doesn’t do the trick
for you, be sure to get the next issue
of TUX, which will include a tutorial
on how to set up and use Guarddog.

— X a v i e r  S p r i e t

Guarddog

About Guarddog:

• License: GNU General Public
License (GPL)

• Price: Free
• Home Page:

http://www.simonzone.com/
software/guarddog

Guarddog Zone Configuration Dialog

Protocol Management Dialog
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Our addiction for fresh, quality infor-
mation at all times is quickly becom-
ing overwhelming. It becomes harder
and harder to keep up with the flow
of information from sites like
Slashdot, fark.com, CNN or even our
friends’ and family’s blogs.

News aggregators, such as Liferea
(Linux Feed Reader), have emerged
as a convenient and elegant solution
that centralizes the flow of data in
one place.

Many of
the modern
content-based
Web sites you
encounter
today include a
feature called
RSS Feed. You
will recognize
these sites

from the RSS button that will point
you to a document written according
to the RSS specifications.

Simply instruct Liferea to monitor
a Web site and it periodically will
check for updates and display a
notification on your screen as soon
as the Web site has been updated.

Liferea lets you manage the
feeds you are monitoring, organize
them into folders and run searches
against them.

A dialog prompts you for all the
information required in order to
subscribe to a feed. Although the
most direct approach is to provide
Liferea with the complete path to
the RSS document on the Web
site, it is usually possible simply to
enter the address of the Web site
itself, and Liferea will attempt to
locate the associated RSS feed.

Feeds in Liferea are organized

much like messages in a typical 
e-mail client. Selecting a feed 
displays a list of new items in the
upper panel, and selecting a news
item from the upper panel displays
the complete description in the
preview pane.

The application also allows you
to create Virtual Folders that let
you display a set of news items
from all the feeds you are monitor-
ing, provided they match a certain
set of criteria. Criteria available
while creating virtual folders
include status (read/unread), flags,
date or a set of keywords.

The configuration options allow
you to reconfigure the placement
of the notification bubble (by
default located on the top-left cor-
ner of your screen), the site refresh
interval, system tray status icon, as

well as a lot of additional features
of the application.

Liferea automates the process of
gathering and organizing the flow
of data from the Web sources that
matter to you, so you can be sure
you never miss important news on
your best-friend’s on-line journal,
and that you are the first to know
about important world events.

— X a v i e r  S p r i e t

Liferea

About Liferea:

• License: GNU General Public
License (GPL)

• Price: Free
• Home Page:

http://liferea.sourceforge.net

RSS Buttons

Liferea Feeds List

Liferea Subscription Dialog

Liferea News Panes
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tsclient is a simple and coherent front
end for a variety of remote desktop
access applications commonly avail-
able on Linux desktops. Some of the
protocols supported by tsclient include
RDP (the default Microsoft Windows
Remote desktop system), VNC (more
common on Linux desktops, though
also available for Windows) or ICA
(Citrix Metaframe).

tsclient provides compatibility
with the Windows Remote Desktop
client through the use of the same
format for saving and loading
remote desktop profiles. This means

you can export all your remote desk-
top profiles from your Windows
computer and load these connection
profiles directly in tsclient.

Additionally, the various tabs
located on the top of the application
allow you to configure various
aspects of the connection you are
about to establish, such as screen
resolution, color depth, sound event
management and so on.

For those who haven’t yet had a
chance to play with that particular
aspect of the operating system (most
graphical operating systems support
some form of remote desktop
access), it is incredibly easy to set up
and access remote desktops. Both

KDE and GNOME provide their own
implementation of shared desktop
through the VNC protocol.

In GNOME 2.10, the Remote
Desktop entry in the Preferences
menu allows you to share your
desktop and specify access policies

(password protection) and privileges
(allow users to take control of your
desktop). In Windows, the Services
management tool allows you to turn
on the built-in RDP server.

Once the remote desktop service
is running on the host you are trying
to access, simply fire up tsclient,
specify the protocol to use (typically,
RDP or RDPv5 for Windows and VNC

for Linux),
enter the IP
address of the
machine you
want to access
as well as a
user name and
password, and
a new window
will show up
on your desk-
top with the
entire desktop
of the remote
machine run-
ning inside.

— X a v i e r  S p r i e t

tsclient About tsclient:

• License: GNU General Public
License (GPL)

• Price: Free
• Home Page:

http://www.gnomepro.com/tsclient

Main tsclient Dialog tsclient Connection Preferences

Enabling Remote Desktop under GNOME

Remote Windows Desktop Running on a GNOME Desktop

http://www.gnomepro.com/tsclient
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With the cost of bandwidth slowly
decreasing and the increasing number
of on-line radio stations available, it 
has become difficult to pick a single
favourite among them all. On-line radio
station directories have emerged as a
way to organize radio stations in coher-
ent categories on dedicated Web sites.

streamtuner maintains a search-
able list of on-line radio stations from
multiple directories and instructs your
favourite audio player to switch from
one station to another without having
to find it by searching through all
available directories.

The application displays a list of
available categories in the left pane
and a list of stations available with
regard to the selected category in
the main pane.

Another interesting feature of
streamtuner is the integration with
Streamripper, a command-line-based
utility that allows you to record on-line
audio streams on your local system.

The main streamtuner interface
features a toolbar that lets you listen,
record or stop streams, as well as
reload the list or visit the Web site
associated with a specific stream.
Under the main toolbar is a set of
tabs representing the radio directories
for which you have enabled support.

If you know what you are doing,
the Preferences dialog also allows
you to customize the commands the
application runs in order to play and
record streams, as well as what
browser to use.

Making the application interface
with Rhythmbox was a breeze.
Simply replace the command for the
action titled Listen to a stream with
rhythmbox, and off you go!

streamtuner also offers a stream
search feature. The scope of that
search is the directory you have
selected, so you need to run sepa-
rate searches for each of the station
directories if you cannot find the
song or station you are looking for in
the default directory (SHOUTcast).

— X a v i e r  S p r i e t

streamtuner

About streamtuner:

• License: Revised BSD License
• Price: Free
• Home Page:

http://www.nongnu.org/streamtuner

streamtuner Stations List

streamtuner User Interface Elements

streamtuner Preferences Dialog
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Over and over again, we hear from people in
various software companies telling us that piracy
hurts their industry. “Boo-hoo”, I hear you say.
“Piracy hurts the consumer by jacking up the
price”—righto. As far as most of us are con-
cerned, piracy is something that doesn’t affect us;
it simply means that the BMW-driving-industry-
heads don’t get such a fat check at the end of the
month. But, have you ever considered the effect
that piracy has on open-source software?

At first glance, piracy might seem to be “all in
the spirit” of the open-source movement—a
seemingly left-wing cause, designed to give big
companies a run for their money and a way to
“stick it to the man”. Anarchists with CD burners
pumping out free copies of proprietary programs
should be all in the same vein, right? Wrong.
Piracy hurts open-source projects in two big ways.

First, piracy helps to establish and cement
major proprietary programs as the industry
standard. Many people take for granted that they
simply can download a CD image from a warez
site or get their friends to copy the original. This
makes for easy access to major software suites
with zero dollars paid, and the software then
spreads like wildfire. If everyone else is using this
particular piece of software, then so must you, or
otherwise you’ll be left behind. This means that
an open-source program will be fighting more and
more against a popular commercial alternative.

Second, piracy makes open-source equivalents
look inferior. With the removal of social con-
science in regards to copying, no longer will a
user make a choice based on the traditional
parameters of budget, suitability and effective-
ness. Piracy removes the cost factor, leaving the
biggest and best as the only viable choice. Let’s
take a look at some real-life examples of commer-
cial software and their open-source equivalents.

ADOBE PHOTOSHOP
Photoshop is widely regarded as the best image
editor industry-wide, and the yardstick by which
other editors are measured. All of my graphic
designer friends use Photoshop, and none of
them have paid for it. I’ve given them The GIMP,
and although they all liked it to a point, none of
them viewed it as a viable alternative to
Photoshop, due to it not being as fully featured,
among other issues like adjusting to another inter-
face, which makes it harder to use at first.

However, none of them felt the sting of shelling
out hundreds of dollars for this advanced piece of
software, and therefore, none of them are able to
make a proper comparison. The GIMP developers do
a lot of hard work trying to make a free alternative
to commercial graphic editors, and all I ever hear is,
“it’s not as good as Photoshop.” Unpaid volunteers
are competing against paid software designers and
are being unappreciated by the masses.

MICROSOFT OFFICE
Office needs no introduction; it is used daily 
by millions, Microsoft’s ubiquitous product 
has been around for more than a decade. 
Most people I know either got it preloaded 
on their new PC, or more likely, had it copied
by a friend. The open-source alternative,
OpenOffice.org, is gaining more and more pop-
ularity, but its importance is still not grasped by
many who simply rely on a copy of Microsoft
Office lying around (not a legally licensed one).
If every user realized how much money they
really owed Microsoft and had to pay-up,
they’d be switching in droves!

If we were looking at the world of cars,
where cost factor is still the main equation,
most people would be going for the smaller,
more economical version. Only those that could
afford it or genuinely need it would buy a bigger
car. In the software world, we simply can steal
the biggest and best and no one is bothered by
it. Why? Because everybody does it. Obviously,
we need the return of the old social conscience,
but that’s easier said than done. How to com-
bat piracy is outside the scope of this article,
but we can at least cut down piracy in our 
own community. If a friend wants an illegal
copy of a commercial program, please don’t
give it to them, but feel free to give them an
open-source alternative.�

John Knight is a 20-year-old, rock-
climbing, Japan-loving megalomaniac,
trying to take over the world from his
bedroom via his keyboard. He spends
most of his time tinkering with MPlayer
and headbanging to his MP3s.

Why Piracy Hurts Open Source
A proper view of open source is the right alternative to piracy.

JOHN KNIGHT

47www.tuxmagazine.com

THE LAST WORD

http://www.tuxmagazine.com

	Cover
	Table of Contents
	P2P
	From The Publisher: Easy Does It
	From The Editor: How to Make Linux Perfect for the Desktop
	Letters
	Q&A with Mango Parfait

	HOME PLATE
	Let a Tomboy Manage Your Notes

	SUITED UP
	Getting Started with OpenOffice.org Calc

	TUX EXPLAINS
	Introduction to Linux Security, Part I
	Scrapbooks and Albums
	Windows-to-Linux Migration with Qt

	REVIEWS
	Libranet 3.0
	Gadget Guy: Products with Drive
	palmOne LifeDrive Mobile Manager
	Seagate 400GB External Drive

	Guarddog
	Liferea
	tsclient
	streamtuner

	THE LAST WORD
	Why Piracy Hurts Open Source




